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Copyrights

© Cypress Semiconductor Corporation, 2014-2015. The information contained herein is subject to change without notice.
Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a
Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted
nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an
express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components
in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user.
The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such
use and in doing so indemnifies Cypress against all charges. 

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by
and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty
provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create
derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom
software and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as
specified in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this
Source Code except as specified above is prohibited without the express written permission of Cypress. 

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS
MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials
described herein. Cypress does not assume any liability arising out of the application or use of any product or circuit
described herein. Cypress does not authorize its products for use as critical components in life-support systems where a
malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product
in a life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies
Cypress against all charges. 

Use may be limited by and subject to the applicable Cypress software license agreement. 

CySmart, F-RAM, PRoC, Programmable System-on-Chip, and PSoC Creator are trademarks, and PSoC and CapSense are
registered trademarks of Cypress Semiconductor Corporation. All other products and company names mentioned in this
document may be the trademarks of their respective holders.

Purchase of I2C components from Cypress or one of its sublicensed Associated Companies conveys a license under the
Philips I2C Patent Rights to use these components in an I2C system, provided that the system conforms to the I2C Standard
Specification as defined by Philips. As from October 1st, 2006 Philips Semiconductors has a new trade name - NXP
Semiconductors.

Flash Code Protection

Cypress products meet the specifications contained in their particular Cypress Datasheets. Cypress believes that its family of
products is one of the most secure families of its kind on the market today, regardless of how they are used. There may be
methods, unknown to Cypress, that can breach the code protection features. Any of these methods, to our knowledge, would
be dishonest and possibly illegal. Neither Cypress nor any other semiconductor manufacturer can guarantee the security of
their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Cypress is willing to work with the customer who is concerned about the integrity of their code. Code protection is constantly
evolving. We at Cypress are committed to continuously improving the code protection features of our products.
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Safety Information

The CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit is intended for use as a
development platform for hardware or software in a laboratory environment. The board is an open
system design, which does not include a shielded enclosure. Therefore, the board may cause
interference with other electrical or electronic devices in close proximity. 

In a domestic environment, this product may cause radio interference. In such cases, the user
should take adequate preventive measures. Also, this board should not be used near any medical
equipment or critical RF devices. The kit is not intended for general consumer use. Cypress
recommends that the kit only be used in a shielded room.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-042-BLE, as shipped from the factory, has been verified to meet with the
requirements of CE as a Class A product.

CY8CKIT-042-BLE boards contain ESD-sensitive devices.
Electrostatic charges readily accumulate on the human body and any
equipment, and can discharge without detection. Permanent damage
may occur on devices subjected to high-energy discharges. Proper
ESD precautions are recommended to avoid performance degradation
or loss of functionality. Store unused CY8CKIT-042-BLE boards in the
protective shipping package.

End-of-Life/Product Recycling

The end-of-life cycle for this kit is five years from the date of
manufacture mentioned on the back of the box. Contact your nearest
recycler to discard the kit.
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General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform
procedures only at an ESD workstation. If an ESD workstation is not available, use appropriate ESD
protection by wearing an antistatic wrist strap attached to the chassis ground (any unpainted metal
surface) on the board when handling parts.

Handling Boards

CY8CKIT-042-BLE boards are sensitive to ESD. Hold the board only by its edges. After removing
the board from its box, place it on a grounded, static-free surface. Use a conductive foam pad if
available. Do not slide the board over any surface.

Battery Care and Use

■ Use the correct size and type of battery specified in this guide. 

■ Keep battery contact surfaces and battery compartment contacts clean by rubbing them with a 
clean pencil eraser or a rough cloth each time you replace batteries. 

■ Remove the battery from a device when it is not expected to be in use for several months. 

■ Make sure that you insert the battery into your device properly, with the + (plus) and – (minus) 
terminals aligned correctly. 

■ Do not place the battery next to metallic objects such as keys and coins.

■ Never throw the battery into fire.

■ Do not open up the battery.

■ Do not short the battery.

■ Do not subject the battery to high temperatures or high humidity.

■ Store the battery in a dry place.

■ Do not recharge a battery unless it is marked “rechargeable.”

Battery Disposal

Batteries can be safely disposed with normal household waste. Never dispose batteries in fire
because they can explode. It is important not to dispose large amounts of batteries in a group. Used
batteries are often not completely “dead.” Grouping used batteries together can bring these “live”
batteries into contact with one another, creating safety risks.
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Regulatory Compliance Information

The CY8CKIT-042-BLE kit contains devices that transmit and receive radio signals in accordance
with the spectrum regulations for the 2.4-GHz unlicensed frequency range. 

Cypress Semiconductor Corporation has obtained regulatory approvals for this kit to be used in
specific countries. These countries include the United States (FCC Part 15), Canada (IC RSS210),
and Japan (JRF/TELEC). Additional regional regulatory agency approval may be required to operate
these throughout the world.

This kit, as shipped from the factory, has been tested and found to comply with the limits and
requirements for the following compliances: 

■ As a Class B digital device, pursuant to part 15 of the FCC Rules.

■ As a Class B digital apparatus, compliant with Canadian ICES-003.

Regulatory Statements and Product Labeling

United States (FCC)

The CY8CKIT-142 PSoC 4 BLE and CY5671 PRoC BLE modular transmitter complies with Part 15
of the Federal Communications Commission (FCC) Rules. The FCC ID for these devices are WAP-
CY8CKIT-142 and WAP-CY5671. 

Operation is subject to the following two conditions: 

■ This device may not cause harmful interference

■ This device must accept any interference received, including interference that may cause unde-
sired operation. 

CAUTION: Changes or modifications not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment. The antennas for this
transmitter must be installed to provide a separation distance of 20 cm from all persons and must not
be co-located or operating in conjunction with any other antenna or transmitter.

Canada (IC)

This device complies with the Industry Canada license-exempt RSS standard(s). Operation is sub-
ject to the following two conditions: 

■ This device may not cause interference.

CAUTION: 

Only the PCB antenna(s) that were certified with the module may be
used. Other antennas may be used only if they are of the same type
and have the same or lower gain.

The module must be recertified as a Class II permissive change if
the module is built into a different device than the evaluation board
(EVB) it was certified with.

The manufacturer is not responsible for any radio or television
interference caused by unauthorized modifications to this
equipment. Such modifications could void the user's authority to
operate the equipment.
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■ This device must accept any interference, including interference that may cause undesired oper-
ation of the device.

This equipment complies with radio frequency exposure limits set forth by Industry Canada for an
uncontrolled environment. This equipment should be installed and operated with minimum distance
20 cm between the device and the user or bystanders.

CAUTION: Any changes or modifications not expressly approved by the party responsible for com-
pliance could void the user’s authority to operate the equipment.

Contains IC: 7922A-CY8CKIT142 and 7922A-CY5671

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio
exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit
pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique
subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Cet équipement est conforme aux limites d'exposition aux radiofréquences définies par Industrie
Canada pour un environnement non contrôlé. Cet équipement doit être installé et utilisé avec un
minimum de 20cm de distance entre le dispositif et l'utilisateur ou des tiers.

Contains IC: 7922A-CY8CKIT142 and 7922A-CY5671

Japan (TELEC)
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1. Introduction

Thank you for your interest in the CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit. The
BLE Pioneer Kit enables customers to evaluate and develop BLE projects using the PSoC® 4 BLE
and PRoC™ BLE (Programmable Radio-on-Chip) devices.

Bluetooth SMART™ or Bluetooth Low Energy (BLE) is a full-featured, layered, communication
protocol that includes a 2.4-GHz radio, a link layer, and an application layer. However, you do not
need to understand the complex protocol to implement your projects using PSoC 4 BLE or PRoC
BLE. The Cypress BLE solution, which includes the device, the BLE Component, and the BLE
firmware stack will take care of it for you. The Cypress BLE firmware stack is royalty free.

You will use two software tools, PSoC Creator™ and CySmart™ Central Emulation Tool, to develop
and debug your BLE project. PSoC Creator is Cypress’ standard integrated design environment
(IDE). The BLE protocol has been abstracted into an easy drag-and-drop BLE Component in PSoC
Creator. The CySmart Central Emulation Tool is a host tool for Windows PCs, which provides an
easy-to-use GUI to enable customers to test and debug their BLE projects. 

The BLE Pioneer Kit offers footprint-compatibility with Arduino™ shields as well as 6-pin Digilent®

Pmod™ daughter cards. In addition, the kit features a CapSense® slider, an RGB LED, a push-
button switch, an onboard programmer/debugger and the USB-UART/I2C bridge functionality block
(KitProg), a coin cell battery holder, and a Cypress F-RAM™. The BLE Pioneer Kit supports 1.9 V,
3 V, 3.3 V, or 5 V as operating voltages. 

The BLE Pioneer Kit supports two devices: 

■ PSoC 4 BLE is a 32-bit, 48-MHz ARM® Cortex®-M0 BLE solution with CapSense, 12-bit analog 
front end (1x SAR ADC, 4x low-power opamps, 2x low-power comparators, and 2x current 
DACs), 4x TCPWM1, 2x SCBs2, 4x UDBs3, LCD4, I2S5, and 36 GPIOs. 

PSoC 4 BLE provides a complete solution for sports and fitness monitors, wearable electronics, 
medical devices, home automation systems, and sensor-based low-power systems for the Inter-
net of Things (IoT). 

■ PRoC BLE is a 32-bit, 48-MHz ARM Cortex-M0 BLE solution with CapSense, 12-bit ADC, 4x 
TCPWM1, 2x SCBs2, LCD4, I2S5, and 36 GPIOs. 

PRoC BLE provides a complete solution for BLE connectivity, HID, remote controls, and toys.

Both devices are available in 128KB and 256KB flash configurations. 

Both devices are supported by royalty-free protocol stacks compatible with Bluetooth 4.1 and
Bluetooth 4.2. 

1. Configurable timer, counter, and pulse-width modulator.
2. Serial communication blocks (configurable to I2C, SPI, or UART).
3. Universal digital blocks
4. Configurable liquid crystal display driver.
5. Configurable integrated interchip sound serial bus interface.
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1.1 Kit Contents

The BLE Pioneer Kit contains the following items (see Figure 1-1):

■ BLE Pioneer Baseboard preloaded with the CY8CKIT-142 PSoC 4 BLE Module

■ CY5671 PRoC BLE Module

■ CY5670 CySmart USB Dongle (BLE Dongle)

■ Quick start guide

■ USB Standard-A to Mini-B cable

■ Four jumper wires (4 inch) and two proximity sensor wires (5 inch)

■ Coin cell (3-V CR2032)

Figure 1-1.  Kit Contents

The BLE Modules that are shipped as part of the BLE Pioneer Kit support 128KB flash and Bluetooth
4.1. The BLE Modules that support 256KB flash and Bluetooth 4.2 can be ordered separately. For
more information about these modules, refer to BLE Modules and BLE Dongles Compatible with the
BLE Pioneer Kit on page 149.

If any part of the BLE Pioneer Kit is missing, contact your nearest Cypress sales office for help:
www.cypress.com/go/support.
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1.2 BLE Pioneer Baseboard Details

The BLE Pioneer Baseboard consists of the blocks shown in Figure 1-2.

1. RGB LED

2. BLE device reset button

3. CapSense proximity header

4. User button

5. CapSense slider

6. Arduino-compatible I/O headers (J2/J3/J4)

7. Arduino-compatible power header (J1)

8. Digilent Pmod-compatible I/O header (J5)

9. Cypress F-RAM 1 Mb (FM24V10-G)

10.PSoC 5LP I/O header (J8)

11.PSoC 5LP programmer and debugger (CY8C5868LTI-LP039)

12.Coin cell holder (bottom side)

13.USB connector (J13)

14.Power LED and Status LED

15.System power supply jumper (J16) - LDO 1.9 V~5 V

16.BLE power supply jumper / current measurement (J15)

17.BLE module headers (J10/J11)

Figure 1-2.  BLE Pioneer Baseboard
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Figure 1-3 shows a markup of the onboard components of the PSoC 4 BLE module (in red) and the
PRoC BLE module (in black). See BLE Modules and BLE Dongles Compatible with the BLE Pioneer
Kit on page 149 for more details. Figure 1-4 shows the BLE Dongle board blocks.

Figure 1-3.  BLE Module Markup

Figure 1-4.  BLE Dongle Markup

32.768-kHz
crystal

32.768-kHz
crystal

Feature List and Pinout Description for CySmart USB Dongle
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1.3 PSoC Creator

PSoC Creator™ is a state-of-the-art, easy-to-use integrated design environment (IDE). It introduces
revolutionary hardware and software co-design, powered by a library of pre-verified and pre-
characterized PSoC Components. With PSoC Creator, you can:

1. Drag and drop Components to build your hardware system design in the main design workspace

2. Codesign your application firmware with the PSoC hardware

3. Configure Components using configuration tools

4. Explore the library of 100+ Components

5. Review Component datasheets

Figure 1-5.  PSoC Creator Features

PSoC Creator also enables you to tap into an entire tool ecosystem with integrated compiler chains
and production programming programmers for PSoC devices.

For more information, visit www.cypress.com/psoccreator. Visit PSoC Creator training page for video
tutorials on learning and using PSoC Creator.
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1.3.1 PSoC Creator Code Examples

PSoC Creator includes a large number of code examples. These examples are available from the
PSoC Creator Start Page, as Figure 1-6 shows.

Code examples can speed up your design process by starting you off with a complete design,
instead of a blank page. The code examples also show how PSoC Creator Components can be
used for various applications. Code examples and documentation are included, as shown in
Figure 1-7 on page 16.

In the Find Example Project dialog shown in Figure 1-7, you have several options:

■ Filter for examples based on architecture or device family, that is, PSoC 3, PSoC 4 or PSoC 5LP; 
project name; or keyword.

■ Select from the menu of examples offered based on the Filter Options.

■ Review the example project’s description (on the Documentation tab).

■ Review the code from the Sample Code tab. You can copy the code from this window and paste 
to your project, which can help speed up code development.

■ Create a new project (and a new workspace if needed) based on the selection. This can speed 
up your design process by starting you off with a complete, basic design. You can then adapt that 
design to your application.

Figure 1-6.  Code Examples in PSoC Creator
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Figure 1-7.  Code Example Projects with Sample Code

1.3.2 Kit Code Examples

This kit includes a number of code examples, which can be used to quickly evaluate the functionality
of this kit. These examples are described in the Example Projects chapter on page 37.

1.3.3 PSoC Creator Help

Visit the PSoC Creator home page to download the latest version of PSoC Creator. Then, launch
PSoC Creator and navigate to the following items:

■ Quick Start Guide: Choose Help > Documentation > Quick Start Guide. This guide gives you 
the basics for developing PSoC Creator projects.

■ Simple Component example projects: Choose File > Code Example. These example projects 
demonstrate how to configure and use PSoC Creator Components.

■ System Reference Guide: Choose Help > System Reference Guide. This guide lists and 
describes the system functions provided by PSoC Creator.

■ Component datasheets: Right-click a Component and select Open Datasheet, as shown in 
Figure 1-8 on page 17. Visit the PSoC 4 Component Datasheets page for a list of all PSoC 4 
Component datasheets.

■ Document Manager: PSoC Creator provides a document manager to help you to easily find and 
review document resources. To open the document manager, choose the menu item Help > 
Document Manager.
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1.3.4 Component Datasheets

Right-click a Component and select Open Datasheet (see Figure 1-8 on page 17).

Figure 1-8.  Opening Component Datasheet

1.4 Getting Started

This guide will help you get acquainted with the BLE Pioneer Kit:

■ The Software Installation chapter on page 21 describes the installation of the kit software. This 
includes the PSoC Creator IDE for development and debugging applications, PSoC Programmer 
for programming hex files, and the CySmart Central Emulation Tool for BLE Central emulation.

■ The Kit Operation chapter on page 25 describes the major features of the BLE Pioneer Kit such 
as USB-UART and USB-I2C bridges and functionalities such as programming and debugging.

■ The Example Projects chapter on page 37 describes multiple PSoC 4 BLE and PRoC BLE code 
examples that will help you understand how to create your own BLE application using the BLE 
Component and device.

■ The Hardware chapter on page 108 details the hardware content of the BLE Pioneer Kit and BLE 
Dongle, and the hardware operation.

■ The Advanced Topics chapter on page 135 explains the functionality of FM24V10 F-RAM.

■ The Appendix on page 137 provides the bill of materials (BOM), KitProg LED states, list of BLE 
modules and dongles compatible with the BLE Pioneer Kit, migrating projects across Pioneer 
series kits, and programming BLE modules using MiniProg3.

1.5 Additional Learning Resources

Cypress provides a wealth of information at www.cypress.com to help you to select the right PSoC
device for your design, and to help you to quickly and effectively integrate the device into your
design. For a comprehensive list of resources, see KBA86521, How to Design with PSoC 3, PSoC 4,
and PSoC 5LP. 

Visit www.cypress.com/go/psoc4ble and www.cypress.com/procble for additional learning resources
including datasheets, technical reference manuals, and application notes.The following is an abbre-
viated list:

■ Overview: PSoC 4 BLE Portfolio and PSoC Roadmap

■ Product Selectors: PSoC 1, PSoC 3, PSoC 4, or PSoC 5LP. In addition, PSoC Creator includes a 
device selection tool.

■ Datasheets: Describe and provide electrical specifications for the PSoC 4 device family

■ CapSense Design Guide: Learn how to design capacitive touch-sensing applications with the 
PSoC 4 family of devices.

■ Application Notes and Code Examples: Cover a broad range of topics, from basic to advanced 
level. Many of the application notes include code examples. Visit the PSoC 3/4/5 Code Examples 
webpage for a list of all available PSoC Creator code examples. To access code examples from 
within PSoC Creator, see PSoC Creator Code Examples on page 15.
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■ Technical Reference Manuals (TRM): Provide detailed descriptions of the architecture and 
registers in each PSoC 4 device family.

■ Development Kits:

❐ CY8CKIT-040, CY8CKIT-042, and CY8CKIT-044 are easy-to-use and inexpensive develop-
ment platforms. These kits include connectors for Arduino-compatible shields and Digilent 
Pmod peripheral modules.

❐ CY8CKIT-141, CY8CKIT-143, CY8CKIT-143A, CY5674, CY5676, and CY5676A are addi-
tional BLE Modules compatible with the BLE Pioneer Kit.

❐ CY5677 is additional BLE Dongle compatible with the BLE Pioneer Kit.

❐ CY8CKIT-049 is a very low-cost prototyping platform for PSoC 4100/4200 families.

❐ The MiniProg3 kit provides an interface for flash programming and debug.

❐ CY5672 PRoC BLE Remote Control Reference Design Kit provides a production-ready imple-
mentation of a Bluetooth Low Energy remote control.

❐ CY5682 PRoC BLE Touch Mouse Reference Design Kit provides a production-ready imple-
mentation of a Bluetooth Low Energy touch mouse.

■ Knowledge Base Articles (KBA): Provide design and application tips from experts on using the 
device.

■ PSoC Creator Training: Visit www.cypress.com/go/creatorstart/creatortraining for a 
comprehensive list of video trainings on PSoC Creator.

■ Cysmart Central Emulation Tool: Visit www.cypress.com/go/cysmart for information on the 
CySmart Central Emulation Tool.

■ Learning From Peers: Visit www.cypress.com/forums to meet enthusiastic PSoC developers 
discussing the next generation embedded systems on Cypress Developer Community Forums.

1.5.1 Bluetooth Learning Resources

The Bluetooth Developer Portal provides material by the Special Interest Group (SIG) for learning
various aspects of the Bluetooth Low Energy protocol and systems. Some of them are:

■ Training videos

■ GATT profiles

■ Bluetooth community forum

1.5.2 Other Related Resources

■ Digilent Pmod: www.digilentinc.com/pmods/

■ Arduino: http://arduino.cc/en/Main/ArduinoBoardUno

1.6 Technical Support

If you have any questions, our technical support team is happy to assist you. You can create a
support request on the Cypress Technical Support page.

If you are in the United States, you can talk to our technical support team by calling our toll-free
number: +1-800-541-4736. Select option 2 at the prompt.

You can also use the following support resources if you need quick assistance.

■ Self-help.

■ Local Sales Office Locations.
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1.7 Documentation Conventions

1.8 Acronyms

Table 1-1.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:
C:\...cd\icc\

Italics
Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Creator User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:
File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.

Times New Roman
Displays an equation:
2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.

Table 1-2.  Acronyms Used in this Document

Acronym Definition

ADC analog-to-digital converter

API application programming interface

BD address Bluetooth device address

BLE Bluetooth Low Energy

CDC Communications Device Class

COM communication port

DLE data length extension

ECDH Elliptic Curve Diffie-Hellman

DVD digital video disc

ESD electrostatic discharge

F-RAM ferroelectric random access memory

GATT generic attribute profile

GUI graphical user interface 

GPIO general-purpose input/output

I2C inter-integrated circuit

IAS immediate alert service

IDAC current output digital-to-analog converter

IDE integrated development environment

LDO low drop out (voltage regulator)

LE low energy

LED light-emitting diode
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LP low power

LPT line print terminal

MTU maximum transmission unit

OTA over-the-air

PHY physical layer

PrISM Precise Illumination Signal Modulation

PRoC Programmable Radio-on-Chip

PSM protocol service multiplexer

PSoC Programmable System-on-Chip

PWM pulse width modulation 

QFN quad flat no-lead (package)

RDK reference design kit

RGB red green blue

SAR successive approximation register

SIG special interest group

SMA SubMiniature version A

SPI serial peripheral interface 

SWD serial wire debug

TLM telemetry

UART universal asynchronous receiver transmitter

UID universal identifier

URI uniform resource identifier

URL uniform resource locator

USB Universal Serial Bus

UUID universal unique identifier

Table 1-2.  Acronyms Used in this Document

Acronym Definition
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2. Software Installation

This chapter describes the steps to install the software tools and packages on a computer for using
the BLE Pioneer Kit. This includes the IDE in which the projects will be built and used for program-
ming.

2.1 Before You Begin

All Cypress software installations require administrator privileges. Ensure you have the required
privileges on the system for successful installation. Before you install the kit software, close any
other Cypress software that is currently running.

2.2 Install Software

Follow these steps to install the BLE Pioneer Kit software:

1. Download the kit software from www.cypress.com/CY8CKIT-042-BLE. The software is available
in the following formats:

a. CY8CKIT-042-BLE Kit Complete Setup: This installation package contains the files related to
the BLE Pioneer Kit. However, it does not include the Windows Installer or Microsoft .NET
framework packages. If these packages are not on your computer, the installer directs you to
download and install them from the Internet.

b. CY8CKIT-042-BLE Kit Only Package: This executable file installs only the BLE Pioneer Kit
contents, which include code examples, hardware files, and user documents. This package
can be used if all the software prerequisites (listed in step 5) are installed on your computer.

c. CY8CKIT-042-BLE DVD ISO: This file is a complete package, stored in a DVD-ROM image
format, that you can use to create a DVD or extract using an ISO extraction program such as
WinZip or WinRAR. The file can also be mounted similar to a virtual CD/DVD using virtual
drive programs such as ‘Virtual CloneDrive’ and ‘MagicISO’. This file includes all the required
software, utilities, drivers, hardware files, and user documents.

2. If you have downloaded the ISO file, mount it on a virtual drive; if you do not have a virtual drive
to mount, extract the ISO contents using the appropriate ISO extractor (such as MagicISO or
PowerISO). Double-click cyautorun.exe in the root directory of the extracted content or mounted
ISO if “Autorun from CD/DVD” is not enabled on the computer. The installation window will
appear automatically. 

Note: If you are using the “Kit Complete Setup” or “Kit Only Package” file, then go to step 4 for 
installation.
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3. Click Install CY8CKIT-042-BLE Kit to start the installation, as shown in Figure 2-1.

Figure 2-1.  Installer Screen

4. Select the folder in which you want to install the CY8CKIT-042-BLE kit-related files. Choose the
directory and click Next.

5. When you click Next, the CY8CKIT-042-BLE Kit installer automatically installs the required
software, if it is not present on your computer. The following software packages are required: 
Note: For the Kit Only Package, download and install the following prerequisites.

a. PSoC Creator 3.3 or later: Download the latest version from www.cypress.com/psoccreator.

b. PSoC Programmer 3.24 or later: This is installed as part of PSoC Creator installation
(www.cypress.com/programmer).

c. CySmart 1.2 or later: Download the latest version from www.cypress.com/cysmart.
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6. Choose the Typical/Custom/Complete installation type in the Product Installation Overview
window, as shown in Figure 2-2. Click Next after you select the installation type.

Figure 2-2.  Product Installation Overview

7. Read the license agreement and select I accept the terms in the license agreement to
continue with installation. Click Next.

8. When the installation begins, a list of packages appears on the installation page. A green check
mark appears next to each package after successful installation.

9. Click Finish to complete the CY8CKIT-042-BLE kit installation.

10.Enter your contact information or select the Continue Without Contact Information check box.
Click Finish to complete the CY8CKIT-042-BLE kit installation.

11.After the installation is complete, the kit contents are available at the following location:

<Install_Directory>\CY8CKIT-042-BLE Kit

Default location:

Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY8CKIT-042-BLE Kit

Windows 7 (32-bit): C:\Program Files\Cypress\CY8CKIT-042-BLE Kit

Note: For Windows 7/8/8.1 users, the installed files and the folder are read only. To use the installer
example projects, follow the steps outlined in the Example Projects chapter on page 37.

The BLE Pioneer Kit installer also installs the CySmart Central Emulation Tool on your computer.
This software, along with the BLE Dongle, allows the computer to emulate as a BLE Central device.
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2.3 Windows 8.1 USB Selective Suspend Setting

The Windows 8.1 operating system issues a suspend command to a connected USB device if there
is no activity on its USB bus. This may happen to the BLE Pioneer Kit/BLE Dongle if the driver instal-
lation is not complete or the driver is not found. In this situation, as a response to the suspend com-
mand from the operating system, the KitProg will shut down the onboard LDO to remain within the
USB suspend current requirement. Due to this, the BLE Pioneer Kit will not be powered and will not
be functional.

To prevent this, do either of the following:

■ Install the kit software on the Windows 8.1 operating system before using the BLE Pioneer Kit.

■ Disable the USB selective suspend setting for the BLE Pioneer Kit from Power Options on Win-
dows 8.1, by following these steps:

a. From Control Panel, go to Power Options.

b. Click Change Plan Settings corresponding to your power plan.

c. Click Change Advanced Power Settings.

d. Under Advanced settings, expand USB Settings > USB selective suspend setting.

e. Select the Disabled option for Plugged in and On battery operation.

f. Click OK.
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This chapter introduces you to the BLE Pioneer Kit and the features that will be used as part of its
operation. We will discuss features such as USB connection, programming/debugging, and
programmer firmware update. The chapter also describes the USB-UART and USB-I2C bridges
along with the PC tools that can be used to communicate with the BLE device on the BLE Pioneer
Kit.

3.1 Theory of Operation

Figure 3-1, Figure 3-2, and Figure 3-3 show the block diagrams for the BLE Pioneer Baseboard,
PSoC 4 BLE/PRoC BLE Module, and BLE Dongle.

Figure 3-1.  BLE Pioneer Baseboard Block Diagram

The BLE Pioneer Baseboard acts as the baseboard for the PSoC 4 BLE (red module) and PRoC
BLE (black module). The BLE Pioneer Baseboard contains a PSoC 5LP device, that has KitProg
firmware, used as an onboard programmer or debugger, and for the USB-Serial interface.

The baseboard is Arduino form-factor compatible, enabling Arduino shields to be connected on top
of the board to extend the functionality of BLE modules. The board also features a 1-Mb F-RAM, an
RGB LED, a five-segment CapSense slider, a proximity header, a user switch, and a reset switch for
the PSoC 4 BLE and PRoC BLE devices on the module. The Pioneer board supports three voltage
levels: 1.9 V, 3.3 V, and 5 V.
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The BLE Pioneer Baseboard can also be used as a standalone programmer to program and debug
other BLE devices using SWD, and as a USB-Serial interface. The KitProg firmware on PSoC 5LP
device enables bootloading PSoC 5LP over USB to upgrade the firmware. 

Figure 3-2.  PSoC 4 BLE/PRoC BLE Module Block Diagram

This BLE Pioneer Kit includes two modules. These modules act as a basic breakout board for the
CY8C4247LQI-BL483 (PSoC 4 BLE) and CYBL10563-56LQXI (PRoC BLE) device. The
PSoC 4 BLE and PRoC BLE Modules are identical except for the BLE device. Besides these two
modules, there are additional modules available, which can be ordered separately. The complete list
is available in BLE Modules and BLE Dongles Compatible with the BLE Pioneer Kit on page 149.

The BLE Dongle is the wireless interface for the CySmart Central Emulation Tool. It has a PRoC
BLE device for BLE communication and KitProg for onboard programming, debugging, and for the
USB-Serial interface, as shown in Figure 3-3.

The BLE Dongle has a USB Type-A plug to connect the KitProg to the USB port of the host
computer. The KitProg then communicates with the PRoC BLE device over UART or multiplexed I2C
or an SPI bus. The BLE Dongle also features a user LED, a user switch, and a reset switch for the
PRoC BLE device. The dongle is powered directly through the USB port (VBUS) at 5.0 V. 

An additional BLE Dongle supporting Bluetooth 4.2 features is available separately. The complete
list is available in BLE Modules and BLE Dongles Compatible with the BLE Pioneer Kit on page 149.

Figure 3-3.  BLE Dongle Block Diagram
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3.2 KitProg

KitProg is the hardware/firmware block for onboard programming, debugging, and bridge
functionality. It is a common reusable hardware/firmware block used across many Cypress kit
platforms. It consists of a PSoC 5LP, which connects to the computer over an USB interface and
connects to the PSoC 4 BLE or PRoC BLE device over SWD, I2C, and UART pins. 

The KitProg communicates with PSoC Programmer and PSoC Creator software to program/debug
the target PSoC 4 BLE or PRoC BLE over the SWD interface. The main advantage of an onboard
programmer/debugger is that users do not have to buy an extra programmer/debugger hardware.

3.3 BLE Pioneer Kit USB Connection

The BLE Pioneer Kit powers from a computer over the USB interface (J13). It enumerates as a com-
posite device, as shown in Table 3-1. USB drivers required for this enumeration are part of the kit
installer. The kit should be installed properly for its correct operation. 

Visit www.cypress.com/CY8CKIT-042-BLE for the latest kit installer.

Figure 3-4.  KitProg Driver Installation (appearance may differ depending on Windows version)

Table 3-1.  BLE Pioneer Kit Enumerated Interfaces

Port Description

USB Composite Device Composite device

USB Input Device USB-I2C bridge, KitProg command interface

KitProg USB-I2C bridge, programmer, and debugger

KitProg USB-UART USB-UART bridge, which appears as a COM# port
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3.4 Placing Modules on Baseboard

Plug the module into the BLE Pioneer Baseboard on headers J10 and J11, while keeping the
antenna directed outside. Note that the two parallel headers J10 and J11 are not equal (24-pin and
20-pin, respectively) and will not allow the module to be inserted in the opposite direction.

Figure 3-5.  Baseboard with J10 and J11 Headers to Connect Modules

To remove the modules from the BLE Pioneer Kit, hold the BLE Pioneer Kit in one hand and the
module in the other, as shown in Figure 3-6, and pull it out using a rocking motion.

Figure 3-6.  Remove Module Connected on BLE Pioneer Kit
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3.5 Programming and Debugging BLE Device

The BLE Pioneer Kit and BLE Dongle can be programmed and debugged using the KitProg. Before
programming the device, ensure that PSoC Creator and PSoC Programmer are installed on the
computer. See the section Install Software on page 21 for more information.

3.5.1 Programming using PSoC Creator

1. Connect the BLE Pioneer Kit/BLE Dongle to the computer’s USB port, as shown in Figure 3-7. 

Figure 3-7.  Connect USB Cable to J13

2. Load the desired example project in PSoC Creator from File > Open > Project/Workspace. 

3. Build the project by choosing Build > Build <Project Name> or [Shift] [F6], as shown in
Figure 3-8.

Figure 3-8.  Build an Example Project

4. If there are no errors during build, program the firmware by clicking the Program button on the
tool bar or pressing [Ctrl] [F5], as shown in Figure 3-9. This will program the device on the BLE
Pioneer Kit/BLE Dongle and it will be ready for use. 
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Figure 3-9.  Programming Device From PSoC Creator

3.5.2 Debugging using PSoC Creator

For debugging the project using PSoC Creator, follow steps 1 to 5 from Programming using PSoC
Creator on page 29 followed by:

1. Click the Debug icon or press [F5], as shown in Figure 3-10.

Figure 3-10.  Start Debug on PSoC Creator 

2. When PSoC Creator opens in debug mode, use the buttons on the toolbar for debugging.

For more details on using the debug features, see the Cypress application note Getting Started with
PSoC 4 BLE.

3.5.3 Programming using PSoC Programmer

PSoC Programmer (3.24 or later) can be used to program existing hex files into both BLE Pioneer
Kit or BLE Dongle. To do this, follow these steps.

1. Connect the BLE Pioneer Kit or BLE Dongle to a computer and open PSoC Programmer from 
Start > All Programs > Cypress > PSoC Programmer <version> > PSoC Programmer <ver-
sion>.

2. Click the File Load button at the top left corner of the window. Browse for the desired hex file and 
click Open.
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Figure 3-11.  Select Hex File

3. Go to File > Program to start programing the kit with the selected file.

Note: If the hex file does not match the device selected, then PSoC Programmer will throw an 
error of device mismatch and terminate programming.

Figure 3-12.  Program Hex File to Kit

4. When the programming is finished successfully, indicated by a PASS message on the status bar, 
the BLE Pioneer Kit/BLE Dongle is ready for use. Close PSoC Programmer.
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3.6 Updating BLE Dongle for CySmart Central Emulation Tool

The BLE Dongle, provides a BLE Central mode capability using the CySmart Central Emulation Tool
on the computer. The CySmart Central Emulation Tool on the PC is the interface with which to
configure the BLE Dongle and analyze the data transferred after connecting with a BLE Peripheral. 

The BLE Dongle works along with the CySmart Central Emulation Tool, as shown in Figure 3-13.
The CySmart Central Emulation Tool is installed as part of the BLE Pioneer Kit installation and can
be opened from Start > All Programs > Cypress > CySmart <version> > CySmart <version>.
The tool operation is explained in the user guide, which can be accessed from Help > Help Topics.

Figure 3-13.  BLE Dongle Interface on CySmart Central Emulation Tool

If the BLE Dongle contains custom firmware on PRoC BLE, the original CySmart firmware can be
programmed back to restore the CySmart functionality. It must be connected through the USB and
enumerated as KitProg. To do this, follow these steps:

1. Connect the BLE Dongle to the USB port on the computer.

2. Open PSoC Programmer by going to Start > All Programs > Cypress > PSoC Programmer
<version> > PSoC Programmer <version>.

3. Click the File Load button and browse to the location of the 
BLE_4_1_Dongle_CySmart_128K.hex file. The hex file is located at: 
<Install_Directory>\CY8CKIT-042-BLE Kit\<version>\Firmware\BLE Dongle\ 
Hex Files\

Note: If Cypress releases new versions of the CySmart Central Emulation Tool and the BLE 
Dongle firmware, then the CySmart Central Emulation Tool will display a message requesting to 
update the firmware, as shown in the following figures.
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Figure 3-14.  Update BLE Dongle Firmware with Hex from Latest Kit Installer

Figure 3-15.  Update BLE Dongle Firmware with Hex from Web

Choose the .hex file from the respective location and update the BLE Dongle firmware.

Figure 3-16.  Open Hex File
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4. Ensure the other settings match as shown in Figure 3-16. Click the Program button to start
programming. The status bar at the bottom of the PSoC Programmer window will show the
programming status and the result (Pass/Fail).

Figure 3-17.  Programming Hex File to Dongle

5. After programming is completed successfully, the BLE Dongle firmware is updated and can be
used to connect to the CySmart Central Emulation Tool.

3.7 USB-UART Bridge

The KitProg on both the BLE Pioneer Baseboard and BLE Dongle acts as a USB-UART bridge.
When connected to a computer, a device named KitProg USB-UART is available under Ports
(COM & LPT) in the Device Manager. The UART lines between modules and KitProg are hard-wired
onboard, with UART_RX assigned to P1_4 and UART_TX assigned to P1_5 on PSoC 4 BLE/PRoC
BLE device. 

COM terminal software, such as Hyperterminal or TeraTerm, can be used to send and receive data.
UART data sent from PSoC 4 BLE/PRoC BLE device on UART_TX line will be received by the
software. Data entered in the software will be received by PSoC 4 BLE/PRoC BLE on UART_RX
line. Refer to Advanced section in CY8CKIT-042 PSoC 4 Pioneer Kit User Guide for more details.

Table 3-2 lists the specifications supported by the USB-UART bridge.

Table 3-2.  Specifications Supported by USB-UART Bridge

Parameter Supported Values

Baud Rate 1200, 2400, 4800, 9600, 19200, 38400, 57600, and 115200

Data Bits 8

Parity None

Stop Bits 1

Flow Control None

File Transfer Protocols 
supported

Xmodem, 1K Xmodem, Ymodem, Kermit, and Zmodem (only 
speeds greater than 2400 baud)
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3.8 USB-I2C Bridge

The KitProg can function as USB-I2C bridge and communicate with the Bridge Control Panel (BCP)
software utility. When connected to BCP, the KitProg\<serial number> is available under Con-
nected I2C/SPI/RX8 Ports in the BCP. The I2C connection between PSoC 4 BLE/PRoC BLE device
and KitProg is used to transfer data between BCP and the PSoC 4 BLE/PRoC BLE device. The I2C
lines on PSoC 4 BLE/PRoC BLE device are P3_4 (SDA) and P3_5 (SCL), which are hard-wired
onboard to I2C lines of KitProg. The USB-I2C supports I2C speed of 50 kHz, 100 kHz, 400 kHz and
1 MHz.

BCP is installed as part of the PSoC Programmer installation and can be accessed from Start > All
Programs > Cypress > Bridge Control Panel. Refer to the Advanced section in the CY8CKIT-042
PSoC® 4 Pioneer Kit User Guide for more details.

To use the USB-I2C functionality, select the KitProg\<serial number> in the BCP. On successful
connection, the Connected and Powered status box turn green, as shown in Figure 3-18.

Figure 3-18.  KitProg USB-I2C Connected in Bridge Control Panel
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3.9 Updating the KitProg Firmware

The KitProg firmware normally does not require any update. If an update is required, then PSoC Pro-
grammer will display a warning message when the kit is connected to it, as shown in Figure 3-19.

Figure 3-19.  Update KitProg

To update the KitProg, go to the Utilities tab on PSoC Programmer and click Upgrade Firmware, as
shown in Figure 3-20.

Figure 3-20.  Update KitProg from PSoC Programmer
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This chapter demonstrates the functionality of PSoC 4 BLE and PRoC BLE devices using the BLE
Pioneer Kit example projects. Download and install the kit setup file from the kit web page. The
example projects can be accessed on the Start Page of PSoC Creator under Examples and Kits. 

4.1 Using Example Projects

Follow these steps to open and use the example projects:

1. Launch PSoC Creator from Start > All Programs > Cypress > PSoC Creator 3.3 > PSoC
Creator 3.3.

2. On the Start Page, under the Examples and Kits section, choose Kits > CY8CKIT-042-BLE. A
list of example projects appears, as shown in Figure 4-1. Projects named with the prefix
'PSoC_4_BLE_' work on the BLE Pioneer Kit with the PSoC 4 BLE Module; projects named with
the prefix 'PRoC_BLE_' work on the BLE Pioneer Kit with the PRoC BLE Module.

3. Click the desired example project.

Figure 4-1.  Open Example Project from PSoC Creator
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4. Select the folder where you want to save the project and click OK.

5. Every BLE project use a public address set in the BLE Component GUI to advertise and scan,
depending on the role: Peripheral or Central mode. If multiple kits in close proximity have the
same public address, then wrong devices may be connected or connections may fail. To prevent
this, change the Public address (and preferably Device name) in the BLE Component GAP
Settings tab as shown in Figure 4-2. Click OK.

Alternatively, you can select the 'Silicon generated' device address by selecting the check box. 
This way, the Bluetooth device (BD) address is generated using the silicon ID, unique to each 
device. Click OK.

Figure 4-2.  Change BLE Public Address and Name

6. Build the example project by choosing Build > Build <Project Name>, as shown in Figure 4-3. A
hex file will be generated.

Figure 4-3.  Build Project from PSoC Creator
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7. Connect the BLE Pioneer Baseboard to the computer through the USB Mini-B connector J13.
Ensure that the correct module (PSoC 4 BLE or PRoC BLE) is placed on the baseboard,
depending on the project opened.

8. Choose Debug > Program in PSoC Creator, as shown in Figure 4-4.

Figure 4-4.  Program Device in PSoC Creator

9. If the device is not yet acquired, PSoC Creator will open the programming window. Select
KitProg and click the Port Acquire button, as shown in Figure 4-5. 

Note: The serial ID starting with 'BLE' belongs to the BLE Dongle (see Updating BLE Dongle for
CySmart Central Emulation Tool on page 32).

Figure 4-5.  Port Acquire

10.After the device is acquired, it is shown in a structure below the KitProg. Click the Connect but-
ton and then OK to exit the window and start programming, as shown in Figure 4-6.
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Figure 4-6.  Connect Device From PSoC Creator and Program

Note: As stated previously, the BLE Pioneer Kit supports both Cypress BLE devices: PSoC 4 BLE
and PRoC BLE. The description, hardware configurations, and verification method of the example
projects explained in the following sections are valid for both these devices. Unless explicitly
mentioned, the theory and usability for these example projects should be considered the same for
both the modules.

This document refers to the BLE Pioneer Kits, BLE Dongle, and PC/mobile as Central or Peripheral
devices. A Central device is normally the master and requests/commands data from the Peripheral
device. BLE-enabled phones and computers are one such example. Peripheral devices store the
actual data and send it to the Central device when requested. Examples include BLE-enabled
sensors, proximity beacons, and so on.
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4.2 CapSense Slider and LED

4.2.1 Project Description

This project demonstrates connectivity between the BLE Pioneer Kit (acting as a Peripheral and
GATT server device) and CySmart Central Emulation tool or mobile device running the CySmart
mobile application (acting as a Central and GATT client device). This project demonstrates the fol-
lowing:

■ Advertisement with timeout

■ Connection with any Central device

■ Two custom services in single profile

■ Data transfer over BLE custom service using notifications, read, and write

■ Low-power mode implementation for coin-cell operation

The BLE profile in this project consists of two BLE custom services: CapSense and RGB LED. The
CapSense service consists of one custom characteristic, termed as CapSense Slider. The
CapSense slider characteristic is used to send one byte data, ranging from 0 to 100, as notification
to the GATT client device. This data is the finger location read by the CapSense component on the
five-segment slider (CSS1) present on the kit. This characteristics supports notification, which allows
the GATT server to send data to the connected client device whenever new data is available.

The RGB LED service also consists of one custom characteristic, termed as RGB LED Control.
This characteristic supports two operations, read and write, through which the connected GATT cli-
ent device can read data as well as write a new value to the characteristic. This data has four byte
values indicating red, green, blue, and the intensity values to control the onboard RGB LED.

The properties for the custom service/characteristics are configured in the BLE Component under
the Profiles tab, as shown in Figure 4-7.
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Figure 4-7.  Attributes Configuration in BLE Component for Custom Services

The project consists of the following files:

■ main.c/.h

These files contain the main function, which is the entry point and execution of the firmware appli-
cation. They also contain the function definition for initialization of the system and reading the 
CapSense slider data from the CapSense Component.

■ BLEApplications.c/.h

These files contain all the macros and function definitions related to BLE communication and 
operation. They include the event callback function definition that is registered with the BLE Com-
ponent startup and used to send BLE-related events from the BLE stack to the application layer 
for processing. These files contain a method to send CapSense notifications to the GATT client 
device and process the Read and Write commands on the RGB LED characteristic by the GATT 
client device. They update the BLE Connection parameter, which is important for low-power 
mode usage.

■ HandleLowPower.c/.h

These files contain the function to handle low-power mode. This function is continuously called in 
the main loop and is responsible for pushing the BLE hardware block (BLESS) as well as the 
CPU to Deep Sleep mode as much as possible. The wakeup source is either the BLE hardware 
block link layer internal timer or the interrupt from the user button press (SW2). This allows for 
very low power mode implementation and operation using a coin cell.

Additionally, the PRoC BLE version of this project consists of the RGB_PRSm.c/.h file, which con-
tains the function to drive the software-based PrISM method; it also drives the color and intensity on
the RGB LED.

This is the default firmware that comes in the modules shipped with the kit.
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Two projects demonstrate this functionality on two different devices: 

■ PSoC_4_BLE_CapSense_Slider_LED works with the PSoC 4 BLE Module.

■ PRoC_BLE_CapSense_Slider_LED works with the PRoC BLE Module. 

The PSoC 4 BLE project implements RGB color and intensity control using the PrISM component
whereas the PRoC BLE uses the software implementation of the PrISM mode.

Figure 4-8.  TopDesign for PSoC_4_BLE_CapSense_Slider_LED Project
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Figure 4-9.  TopDesign for PRoC_BLE_CapSense_Slider_LED Project
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4.2.2 Hardware Connections

No specific hardware connections are required for this project because all connections are
hardwired on the BLE Pioneer Baseboard. Ensure that the correct module is placed on the
baseboard corresponding to the project being used. PSoC_4_BLE_CapSense_Slider_LED works
with the PSoC 4 BLE Module. PRoC_BLE_CapSense_Slider_LED works with the PRoC BLE
Module.

The pin assignment for this project is in PSoC_4_BLE_CapSense_Slider_LED.cydwr/
PRoC_BLE_CapSense_Slider_LED.cydwr in the Workspace Explorer, as shown in Figure 4-10.

Figure 4-10.  Pin Selection for CapSense Slider and LED Project
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4.2.3 Flow Chart

Figure 4-11 shows the flow chart of the code implemented.

Figure 4-11.  CapSense Slider and LED Project Flow Chart
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4.2.4 Verify Output

The project can be verified by two methods: using the CySmart Central Emulation Tool and BLE
Dongle or using the CySmart mobile application.

4.2.4.1 CySmart Central Emulation Tool

To verify the CapSense and LED project using the CySmart Central Emulation Tool, follow these
steps:

Note: Refer CySmart Central Emulation tool to learn how to use the tool.

1. Connect the BLE Dongle to one of the USB ports on the computer.

2. Start the CySmart Central Emulation Tool on the computer by going to Start > All Programs >
Cypress > CySmart <version> > CySmart <version>. You will see a list of BLE Dongles
connected to it. If no dongle is found, click Refresh. Select the BLE Dongle and click Connect. 

Figure 4-12.  Connect to BLE Dongle

3. Place the module on the BLE Pioneer Kit, depending on the project chosen.

4. Power the BLE Pioneer Kit through the USB connector J13.

5. Program the BLE Pioneer Kit with the CapSense and LED example project. Follow steps in Using
Example Projects on page 37 to program the device.

6. After programming successfully, press the user button (SW2) on the BLE Pioneer Kit to start the
advertisement. Advertisement is indicated by a blinking red LED on the baseboard.

Note: The project has an advertisement timeout of 30 seconds after which it returns to Deep 
Sleep mode. Press SW2 again to restart the advertisement.

7. On the CySmart Central Emulation Tool, click Start Scan to see the list of available BLE
Peripheral devices. 
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8. Double-click the Slider LED device to connect, or click Slider LED and then click Connect.

Figure 4-13.  Connect to BLE Slider and LED Peripheral

9. When connected, the CySmart Central Emulation Tool will display a message for the Update
connection parameters. Select Yes, as shown in Figure 4-14.

Figure 4-14.  Update Connection Parameter Option

Note: If you select No, the project will still work. However, the current consumption will be higher 
due to faster connection interval. 

10.Click Discover All Attributes to find all attributes supported.

Figure 4-15.  Discover All Attributes



CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *G 49

Example Projects

11.Locate the attribute Client Characteristic Configuration descriptor (UUID 0x2902) under
CapSense slider characteristic (UUID 0x0003CAA2-0000-1000-8000-00805F9B0131). Click
Read Value to read the existing Client Characteristic Configuration Descriptor (CCCD) value as
shown in Figure 4-16.

Figure 4-16.  Read CCCD for CapSense Slider Characteristic

12.Modify the Value field of CCCD to '01:00' and click Write Value. This enables the notifications on
the CapSense slider characteristic. 

Figure 4-17.  Write CCCD to Enable Notifications
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13.Swipe your finger on the CapSense slider on the BLE Pioneer kit, as shown in Figure 4-18 and
see the notification values in the CapSense Slider value field, as shown in Figure 4-19. 

Figure 4-18.  CapSense Slider

Figure 4-19.  CapSense Slider Notification Received

14.To disable notifications, modify the Value field of the Client Characteristic Configuration
descriptor to '00:00' and click Write Value.

Figure 4-20.  Disable Notifications

15.Locate the RGB LED Control characteristic (UUID 0x0003CBB1-0000-1000-8000-
00805F9B0131). Click Read Value to read the existing 4-byte onboard RGB LED color informa-
tion, as shown in Figure 4-21. The four bytes indicate red, green, blue, and the overall brightness,
respectively.
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Figure 4-21.  Read RGB LED Control Characteristic Value

16.Modify the four bytes of data in the Value field and click Write Value. You will see the
corresponding change in the color and intensity of the RGB LED on the BLE Pioneer Kit, as
shown in Figure 4-22. The RGB LED will be on for 3 seconds before switching off to conserve
power.

Note: If the kit is powered from a coin cell and not the USB Vbus, then the color mixing and inten-
sity will vary. This is because the coin cell provides a lower driving voltage for RGB LEDs.

Figure 4-22.  Write RGB LED Control Characteristic Value

Figure 4-23.  RGB LED Control with PSoC 4 BLE Module and PRoC BLE Module
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17.To disconnect from the device, click Disconnect, as shown in Figure 4-24.

Figure 4-24.  Disconnect from the Device

18.To connect to this peripheral again, restart advertising by pressing the user button (SW2) on the
BLE Pioneer Kit. Advertising is indicated by the blinking red LED.

4.2.4.2 CySmart Mobile Application

To verify the CapSense and LED project using the CySmart mobile application (refer CySmart
Mobile App webpage), follow these steps:

1. Plug the desired module on the BLE Pioneer Baseboard. 

2. Connect the BLE Pioneer Kit into the computer using the J13 USB connector.

3. Program the kit with the CapSense Slider and LED example project. See Using Example Projects
on page 37 for programming instructions.

4. Press the user button (SW2) on the BLE Pioneer Kit to start the advertisement. This is indicated
by the blinking red LED on the BLE Pioneer Kit.

5. Open the application on the mobile device. If Bluetooth is not enabled on the device, the
application will ask to enable it.

6. After Bluetooth is enabled, the CySmart mobile application will automatically search for available
peripherals and list them. Select the Slider LED peripheral as shown in Figure 4-25.



CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *G 53

Example Projects

Figure 4-25.  Slider LED Peripheral

7. When connected, the CySmart mobile application will list the profiles supported by the peripher-
als. Scroll and select the CapSense icon, as shown in Figure 4-26.

Figure 4-26.  CapSense Service Page

8. Swipe your finger on the CapSense slider on the BLE Pioneer Kit and see a similar response on
the CapSense page in the CySmart application (Figure 4-27).
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Figure 4-27.  CapSense Slider

9. Press the back button to return to the service selection page. Scroll and tap on the RGB LED ser-
vice.

10.On the RGB LED service page, swipe over the color gamut to see a similar color response on the
BLE Pioneer Kit RGB LED. The slider below the color gamut controls the intensity of the RGB
LED color. The RGB LED will be on for 3 seconds before switching off. This is done to conserve
power. 

Figure 4-28.  RGB LED Control with CySmart Mobile Application

11.To disconnect from the BLE Pioneer Kit, return to the CySmart mobile application home screen
by pressing the back button.

12.To reconnect to the Peripheral, press the user button (SW2) on the BLE Pioneer Kit again and
then scan for devices using CySmart mobile application.
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4.3 CapSense Proximity

4.3.1 Project Description

This project demonstrates connectivity between the BLE Pioneer Kit (acting as a Peripheral and
GATT server device) and the CySmart Central Emulation Tool or mobile device running the CySmart
mobile application (acting as a Central and GATT client device). This project demonstrates the
following:

■ Advertisement with timeout

■ Connection with any Central device

■ One custom service

■ Data transfer over BLE custom service using notifications

■ Low-power mode implementation for coin cell operation

The BLE profile in this project consists of a single BLE custom service, called CapSense. The
CapSense service consists of a custom characteristic, termed as CapSense Proximity. The
CapSense proximity characteristic is used to send one byte data, ranging from 0 to 255, as
notification to the GATT client device. This data is the difference count read by the CapSense
component on the one-wire proximity sensor (J14) connected on the kit. This characteristic supports
notification, which allows the GATT server to send data to the connected GATT client device
whenever new data is available.

The properties for the custom attributes are configured in the BLE component under the Profiles tab,
as shown in Figure 4-29.

Figure 4-29.  Attributes Configuration in BLE Component for CapSense Proximity



CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *G 56

Example Projects

The project consists the following files:

■ main.c/.h

These files contain the main function, which is the entry point and execution of the firmware appli-
cation. They contain function definition for initialization of the system and reading the CapSense 
proximity data from the CapSense component.

■ BLEApplications.c/.h

These files contain all the macros and function definitions related to BLE communication and 
operation. They include the event callback function definition that is registered with the BLE Com-
ponent startup and used to send BLE-related events from the BLE stack to the application layer 
for processing. These files contain a method to send CapSense notifications to the GATT client 
device. They update the BLE Connection parameter, which is important for low-power mode 
usage.

■ HandleLowPower.c/.h

These files contain the function to handle low-power mode. This function is continuously called in 
the main loop and is responsible for pushing the BLE hardware block (BLESS) as well as the 
CPU to Deep Sleep mode as much as possible. The wakeup source is either the BLE hardware 
block link layer internal timer or the interrupt from the user button press (SW2). This allows for 
very low-power mode implementation and operation using a coin cell.

The red LED is used as the status LED and provides visual confirmation on advertising or
connection states. A blinking red LED indicates advertising state.

Two projects demonstrate this functionality on two different devices:

■ PSoC_4_BLE_CapSense_Proximity works with the PSoC 4 BLE Module. 

■ PRoC_BLE_CapSense_Proximity works with the PRoC BLE Module. 
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Figure 4-30.  Top Design for PSoC_4_BLE_CapSense_Proximity Project

Figure 4-31.  Top Design for PRoC_BLE_CapSense_Proximity Project
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4.3.2 Hardware Connections

■ Ensure that the correct module is placed on the baseboard corresponding to the project being
used. PSoC_4_BLE_CapSense_Proximity works with the PSoC 4 BLE Module.
PRoC_BLE_CapSense_Proximity works with the PRoC BLE Module.

■ Connect a five-inch wire (provided as part of this kit) to the proximity connector J14 on the
baseboard. Loop the wire as shown in Figure 4-32.

Note: Ensure that the proximity sensor loop wire is kept away as much as possible from the BLE
antenna on the modules.

Figure 4-32.  Proximity Sensor Connection on BLE Pioneer Kit with PSoC 4 BLE Module

Figure 4-33.  Proximity Sensor Connection on BLE Pioneer Kit with PRoC BLE Module

The pin assignment for this project is in PSoC_4_BLE_CapSense_Proximity.cydwr/
PRoC_BLE_CapSense_Proximity.cydwr in the Workspace Explorer, as shown in Figure 4-34.

Figure 4-34.  Pin Selection for CapSense Proximity Project
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4.3.3 Flow Chart

Figure 4-35 shows the flow chart of code implemented.

Figure 4-35.  CapSense Proximity Project Flow Chart
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4.3.4 Verify Output

The project can be verified by two methods: using the CySmart Central Emulation Tool and BLE
Dongle or using the CySmart iOS/Android app.

4.3.4.1 CySmart Central Emulation Tool

To verify the CapSense Proximity project using the CySmart Central Emulation Tool, follow these
steps:

Note: Refer CySmart Central Emulation tool to learn how to use the tool.

1. Connect the BLE Dongle to one of the USB ports on the computer.

2. Start the CySmart Central Emulation Tool on the computer by going to Start > All Programs >
Cypress > CySmart <version> > CySmart <version>. You will see a list of dongles connected
to it. If no dongle is found, click Refresh. Select the BLE Dongle and click Connect.

Figure 4-36.  Connect to BLE Dongle

3. Connect a five-inch wire (included in the kit) to the proximity sensor connector J14 and make a
loop of it.

4. Power the BLE Pioneer Kit through the USB connector J13.

5. Program the BLE Pioneer Kit with the CapSense proximity example project. Follow the steps in
Using Example Projects on page 37 to program the device.

6. After programming successfully, press the user button (SW2) on the BLE Pioneer kit to start the
advertisement. This is indicated by a blinking red LED on the baseboard.
Note: The project has an advertisement timeout of 30 seconds after which it returns to Deep
Sleep mode. Press SW2 again to restart the advertisement.

7. On the CySmart Central Emulation Tool, click Start Scan to see the list of available BLE Periph-
eral devices. 
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Figure 4-37.  Start Scanning

8. Double-click CapSense Proximity to connect or click Connect to connect to the BLE Pioneer
Kit. 

Figure 4-38.  Connect to CapSense Proximity Peripheral

9. When connected, the CySmart Central Emulation Tool will display a message for the Update 
connection parameters. Select Yes, as shown in Figure 4-39.

Figure 4-39.  Update Connection Parameter Option

Note: If you select No, the project will still work. However, the current consumption will be higher 
due to faster connection interval.
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10.Click Discover All Attributes to find all attributes supported by the Peripheral.

Figure 4-40.  Discover All Attributes

11.When all the attributes are listed, locate the Client Characteristic Configuration descriptor
(UUID 0x2902) under CapSense Proximity characteristic (UUID 0x0003CAA1-0000-1000-8000-
00805F9B0131). Click Read Value to read the existing CCCD value as shown in Figure 4-41.

Figure 4-41.  Read CapSense Proximity CCCD

12.Modify the Value field to '01:00' and click Write Value. This enables the notifications on the
CapSense proximity characteristic. 
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Figure 4-42.  Write CCCD to Enable Notifications

13.Bring your hand closer to the proximity sensor on the BLE Pioneer Kit, as shown in Figure 4-43
and observe the value changing in the characteristic value field, as shown in Figure 4-44. 

Figure 4-43.  CapSense Proximity Sensing with PSoC 4 BLE Module

Figure 4-44.  CapSense Proximity Notification Received

14.Modify the Value field of the Client Characteristic Configuration descriptor to '00:00' to disable
notifications.

15.To disconnect from the device, click Disconnect, as shown in Figure 4-45.
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Figure 4-45.  Disconnect from the Device

16.Press user button (SW2) to wake up from sleep and restart the advertisement for the next
connection.

4.3.4.2 CySmart Mobile Application

To verify the CapSense Proximity project using the CySmart mobile application (refer CySmart
Mobile App webpage), follow these steps:

1. Place the desired module on BLE Pioneer Baseboard. 

2. Connect the five-inch wire as a loop to the proximity connector J14 on the baseboard.

3. Plug the BLE Pioneer Kit into the computer, using the J13 USB connector.

4. Program the kit with the CapSense proximity example project. Follow steps in Using Example
Projects on page 37 to program the device.

5. Press the user button (SW2) on the BLE Pioneer Kit to start the advertisement.

6. Open the CySmart mobile application on the mobile device. If Bluetooth is not enabled on the
device, the app will ask to enable it.

7. The app will automatically search for available peripherals and list them. Select the CapSense
Proximity peripheral, as shown in Figure 4-46.

Figure 4-46.  Connect to CapSense Proximity Peripheral
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8. When connected, the app will list the services supported by the peripherals. Scroll and select the
CapSense Proximity service.

9. When the CapSense service page opens, bring your hand near the sensor wire on the BLE
Pioneer Kit and see a similar response in the app as a bar graph, as shown in Figure 4-47.

Figure 4-47.  CapSense Proximity Sensing with PSoC 4 BLE Module

10.To disconnect from the BLE Pioneer Kit, return to the device selection screen on the CySmart
mobile application.

11.To reconnect to the Peripheral, press the user button (SW2) on the BLE Pioneer Kit to restart the
advertisement and scan for the device in the CySmart mobile application.

4.4 BLE Central Mode

4.4.1 Project Description

The BLE projects described above have been functioning as Peripheral devices. This means that
the firmware role was set to be a Peripheral and GATT server; another device such as the CySmart
Central Emulation Tool or CySmart mobile application will connect to it and collect the data.

This example project demonstrates the Central and GATT client mode where it will scan for a Periph-
eral device, connect to it, and send commands. In this project, the BLE Pioneer Kit scans and auto-
connects to a particular Peripheral device supporting Immediate Alert Service (IAS). Whenever the
Peripheral with a predetermined public address is found, a connection request is sent followed by
discovering the attributes. When the discovery is over, you can send one of the three alert levels to
the Peripheral device over the IAS. This is done by pressing the SW2 button on the BLE Pioneer Kit
and cycling through the alert levels.

The BLE Central project supports low-power mode operation, where the firmware supports BLE
Hardware block and CPU Deep Sleep mode whenever possible. The system remains in Deep Sleep
when disconnected. Press SW2 to wake up the system and start scanning (blinking blue LED). The
scanning timeout interval is set to 30 seconds. If a particular Peripheral device is found advertising
before timeout, a connection is made (blue LED always ON). If no such device is found, then the
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system stops scanning and returns to Deep Sleep mode (LED OFF). Press SW2 again to wake the
system and restart scanning.

To aid in evaluation, the Peripheral project with the particular public address is provided in the same
workspace. This Peripheral project supports IAS and has fixed public address that the Central
device will recognize and auto-connect to. The project should be programmed on the BLE Dongle
and powered through the USB port of the computer. The received alert levels (No, Mid, and High
alert) on the BLE Dongle are represented by different LED status. No Alert is represented by LED
OFF, Mid Alert by blinking LED, and High Alert with LED always ON. Upon each successive button
press on the BLE Pioneer Kit, the LED state on the BLE Dongle changes in a circular fashion.

Two projects demonstrate the BLE Central functionality on the two devices:

■ PSoC_4_BLE_Central_IAS works with the PSoC 4 BLE Module. 

■ PRoC_BLE_Central_IAS works with the PRoC BLE Module. 

Additionally, the BLE_Dongle_Peripheral_IAS project is to be programmed on the BLE Dongle.
This project is present in both the PSoC_4_BLE_Central_IAS and the PRoC_BLE_Central_IAS
workspace and can be used to program the BLE Dongle separately. 

Note: If the BLE Dongle is programmed with the BLE_Dongle_Peripheral_IAS example, it will not
work with the CySmart PC utility. Reprogram the BLE Dongle with the CySmart firmware according
to Updating BLE Dongle for CySmart Central Emulation Tool on page 32 to use the CySmart Central
Emulation Tool.

Figure 4-48.  PSoC_4_BLE_Central_IAS TopDesign
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Figure 4-49.  PRoC_BLE_Central_IAS TopDesign

Figure 4-50.  BLE_Dongle_Peripheral_IAS TopDesign
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4.4.2 Hardware Connections

No specific hardware connections are required for this project because all connections are
hardwired on the BLE Pioneer Baseboard. 

Ensure that the correct module is placed on the BLE Pioneer Baseboard corresponding to the proj-
ect being used. PSoC_4_BLE_Central_IAS works with the PSoC 4 BLE Module.
PRoC_BLE_Central_IAS works with the PRoC BLE Module. BLE_Dongle_Peripheral_IAS is the
common project for both workspaces and programs the BLE Dongle with Peripheral mode firmware.

The pin assignment for this project is in PSoC_4_BLE_Central_IAS.cydwr/
PRoC_BLE_Central_IAS.cydwr in the Workspace Explorer, as shown in Figure 4-51.

Figure 4-51.  Pin Selection for BLE IAS Central Example Project

Similarly, the pin assignment for the BLE Dongle Peripheral project is in
BLE_Dongle_Peripheral_IAS.cydwr in the Workspace Explorer as shown in Figure 4-52.

Figure 4-52.  Pin Selection for BLE IAS Peripheral Example Project
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4.4.3 Flow Chart

Figure 4-53 shows the flow chart for the IAS GATT client mode example project.

Figure 4-53.  IAS GATT Client Mode Flow Chart
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Figure 4-54 shows the flow chart for the IAS GATT server mode example project.

Figure 4-54.  IAS GATT Server Mode Flow Chart

4.4.4 Verify Output

1. Connect the BLE Dongle to one of the USB ports on the computer.
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Figure 4-55.  Connect BLE Dongle to USB Port

2. In the PSoC Creator Workspace Explorer, right-click the BLE_Dongle_Peripheral_IAS project
and select Set As Active Project, as shown in Figure 4-56.

Figure 4-56.  Set Dongle Peripheral Project as Active

3. Program the BLE Dongle with the BLE_Dongle_Peripheral_IAS project described in Using
Example Projects on page 37.

Note: Do not update the public device address (inside the BLE component) for the
BLE_Dongle_Peripheral_IAS example project. Changing the BLE_Dongle_Peripheral_IAS
example project public address will lead to no connection with the BLE Central device on the BLE
Pioneer kit.
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4. Power the BLE Pioneer Kit through USB connector J13.

5. In the Workspace Explorer, right-click the PSoC_4_BLE_Central_IAS project and select Set As
Active Project, as shown in Figure 4-57.

Figure 4-57.  Set Central IAS Project as Active

6. Program the BLE Pioneer Kit with either the PSoC_4_BLE_Central_IAS or the
PRoC_BLE_Central_IAS project, depending on the module placed on the BLE Pioneer Kit.

7. Press the SW2 button on the BLE Pioneer Kit to wake the system and start scanning. Scanning is
indicated by a blinking LED.

8. Wait for the BLE connection between the BLE Dongle and the BLE Pioneer Kit. The connection
success status is indicated on the baseboard in the following three stages:

a. Fast blinking blue LED represents scanning mode. During this mode, the BLE Pioneer Kit is
scanning for Peripheral devices.

b. Slow blinking blue LED represents discovery mode. During this mode, the BLE Pioneer Kit
has found the BLE Dongle Peripheral device and has started the connection procedure.

c. The blue LED remains on, representing the connected mode. This mode indicates that the
Peripheral device has been connected and the application can now send alert levels.

9. Press the SW2 button on the BLE Pioneer Kit to send the next alert level to the BLE Dongle. The
alert level will rotate from No Alert to Mid Alert to High Alert. 
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Figure 4-58.  User Button on BLE Pioneer Kit with PSoC 4 BLE Module

10.Check if the LED behavior changes for each alert notification on the BLE Dongle according to the
following table:

Note: To revert the CySmart functionality to the dongle, program the dongle hex file, as described in
Updating BLE Dongle for CySmart Central Emulation Tool on page 32.

4.5 Eddystone

4.5.1 Project Description

This project demonstrates a BLE beacon based on Google's Eddystone™ protocol on the BLE Pio-
neer Kit. A beacon is a wireless device that broadcasts data (such as temperature) over a periodic
radio signal from a known location. BLE-based beacons use the BLE advertisement packets to
broadcast data. This project demonstrates the following:

■ Beacon (non-connectable advertisement)

■ Beacon configuration (connectable advertisement)

Google's Eddystone is a protocol that defines BLE advertisement data formats for beacons. In
Eddystone parlance, the advertisement data is called a frame and the advertisement data format is
called a frame type. The protocol supports multiple frame types that may be used individually or in
combinations to create beacons for a variety of applications.

Alert Level LED State

No Alert LED Off

Mild Alert LED Blinking

High Alert LED On
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Figure 4-59.  Characteristic Configuration in BLE Component for Eddystone Beacon

The BLE profile in this project consists of two BLE custom services, Eddystone and Eddystone
Configuration (see Figure 4-59). The project broadcasts one of the following beacon frames in a
non-connectable advertisement packet.

■ Eddystone-UID frame broadcasts a unique 16-byte Beacon ID composed of a 10-byte 
namespace and a 6-byte instance. The Beacon ID may be useful in mapping a device to a record 
in external storage. The namespace portion of the ID may be used to group a particular set of 
beacons, while the instance ID identifies individual devices in the group. The division of the ID 
into namespace and instance components may also be used to optimize BLE scanning strate-
gies, for example, by filtering only on the namespace. More details are available here.

■ Eddystone-URL frame broadcasts a URL using a compressed encoding format to fit more within 
the limited advertisement packet. More details are available here.

■ Eddystone-TLM frame broadcasts telemetry information about the beacon itself such as battery 
voltage, device temperature, and counts of broadcast packets. More details are available here.

The Eddystone Configuration Service consists of nine characteristics as follows.

■ Lock State – Read returns true if the device is locked.

■ Lock – Locks the beacon and sets the single-use lock-code.

■ Unlock – Unlocks the beacon and clears the single-use lock-code.

■ URI Data – Reads/writes the URI.

■ URI Flags – Reads/writes the flags.

■ Advertised Tx Power Levels – Reads/writes the Advertised Power Levels array.

■ Tx Power Mode – Reads/writes the TX Power Mode.

■ Beacon Period – The period in milliseconds that an Eddystone-URL packet is transmitted.

■ Reset – Resets to default values.

More details on the Eddystone Configuration service can be found here.
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The project consists of the following files:

■ main.c/.h

These files contain the main function, which is the entry point and execution of the firmware appli-
cation. They contain function definitions for initialization and handling low power mode of the sys-
tem. By default on power-on-reset, the system will do a non-connectable advertisement of URL/
URI and TLM packets. When the SW2 button is pressed, the device will enter connectable mode 
and various characteristics can be configured.

■ Eddystone.c/.h

These files contain the functions required to implement the Eddystone protocol including adver-
tisement packet creation (for UID/URL and TLM), advertisement scheduling, and configuration 
read/write. The battery and temperature data are also updated before the TLM packets are con-
structed and advertised.

■ WatchdogTimer.c/.h

These files contain functions that provide necessary timing for the operation of the system.

■ Battery.c/.h

These files contain a function that will measure the battery voltage of the kit. This information is 
advertised as part of the TLM packets.

■ Temperature.c/.h

These files contain a function that will measure the die temperature of the PSoC or PRoC device. 
An external sensor may be attached to measure ambient temperature. This information is adver-
tised as part of the TLM packets.

The green LED indicates UID/URL packet transmissions, the blue LED indicates TLM packet trans-
missions, and the red LED indicates that the device is in connectable mode. In this mode, when con-
nected, the beacon configuration can be modified.

Two projects demonstrate this functionality on two different devices:

■ PSoC_4_BLE_ Eddystone works with the PSoC 4 BLE Module

■ PRoC_BLE_Eddystone works with the PRoC BLE Module
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Figure 4-60.  Top Design for PSoC_4_BLE_Eddystone and PRoC_BLE_Eddystone Project

4.5.2 Hardware Connection

■ Ensure that the correct module is placed on the baseboard corresponding to the project being 
used. PSoC_4_BLE_Eddystone works with the PSoC 4 BLE Module. PRoC_BLE_Eddystone 
works with the PRoC BLE Module.

■ Connect a wire (provided as part of this kit) between VREF (connector J3) and P3.0 (connector 
J2) on the baseboard (see Figure 4-61).

Figure 4-61.  VREF (J3) and P3.0 (J2) Connectors on BLE Pioneer Kit with PSoC 4 BLE Module

The pin assignment for this project is in PSoC_4_BLE_Eddystone.cydwr or
PRoC_BLE_Eddystone.cydwr in the Workspace Explorer, as shown in Figure 4-62.
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Figure 4-62.  Pin Selection for Eddystone Project

4.5.3 Flow Chart

Figure 4-63 shows the flow chart of code implemented.

Figure 4-63.  Eddystone Project Flow Chart

4.5.4 Verify Output

The project can be verified using an Android smart phone or an iOS device (iPhone or iPad). Before
proceeding further make sure that a beacon application (such as Locate Beacon for Android or
Chrome browser for iOS) and the CySmart app are installed on the smart phone/device. Also make
sure that Bluetooth is turned on in the device, and you have a working internet connection.
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To verify the Eddystone project in iOS, using Chrome for iOS browser, follow these steps. Before you
start, make sure the Chrome browser for iOS is installed in your iOS device and the Chrome widget
is added to the widgets view.

1. Place the module on the BLE Pioneer Kit, depending on the project chosen.

2. Power the BLE Pioneer Kit through the USB connector J13.

3. Program the BLE Pioneer Kit with the Eddystone example project. Follow steps in Using Example 
Projects on page 37 to program the device.

4. After programming successfully, the firmware starts the non-connectable advertisement of UID/
URL and TLM packets. Advertisement of UID/URL packets is indicated by the green LED and 
TLM packets is indicated by blue LED on the baseboard.

5. Pull down the notification area. You should be able to see the link in the notification area as 
shown in Figure 4-64 on page 78

Figure 4-64.  iOS Notification Shade Showing the Beacon Advertised Web Link

6. Touching the link will take you to the website.

To verify the Eddystone project in Android devices using the Locate Beacon application, follow these
steps.

1. Place the module on the BLE Pioneer Kit, depending on the project chosen.

2. Power the BLE Pioneer Kit through the USB connector J13.

3. Program the BLE Pioneer Kit with the Eddystone example project. Follow steps in Using Example 
Projects on page 37 to program the device.

4. After programming successfully, the firmware starts the non-connectable advertisement of UID/
URL and TLM packets. Advertisement of UID/URL packets is indicated by the green LED and 
TLM packets is indicated by blue LED on the baseboard.

5. Launch the Locate application on the smart phone/device.
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6. Click the Locate Beacons button to start scanning for beacons (see Figure 4-65).

Figure 4-65.  Locate Beacon App Home Screen

7. In the next screen a list of Visible Beacons will be displayed. Click the desired beacon (see 
Figure 4-66) to display its status and information (see Figure 4-67).

Figure 4-66.  Locate Beacon App Showing Discovered Beacons
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Figure 4-67.  Locate Beacon Showing Details about Selected Beacon

To read and write characteristics (using an Android or iOS device, and CySmart app) of the beacon
follow these steps.

1. Press SW2 on the BLE Pioneer Kit baseboard to start the connectable advertisement. The adver-
tisement state is indicated by the red LED.

2. Launch the CySmart app on your Android smart phone/device.

3. Connect to the CY Eddystone device from the list by clicking on it (see Figure 4-68).
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Figure 4-68.  CySmart App Showing the CY Eddystone Beacon

4. Click the GATT DB menu option (see Figure 4-69).

Figure 4-69.  CySmart Showing GATT DB Option for CY Eddystone Device
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5. Click on Unknown Service (see Figure 4-70) to see all available characteristics.

Figure 4-70.  CySmart Showing Unknown Service in GATT DB

6. Click on any of the characteristics to read and modify it. For reference on Eddystone Configura-
tion characteristics, refer to the Google Eddystone page. To understand more about the CySmart 
app, refer to the CySmart user guide.

7. Disconnect from the device to go back to the beacon mode.

4.6 Over-the-Air (OTA) Device Firmware Upgrade and Bluetooth 4.2 
Features

4.6.1 Project Description

This project showcases some of the advanced features of the Cypress BLE solution, using the BLE
Pioneer Kit (acting as a Peripheral and GATT Server device) and the CySmart Central Emulation
Tool (acting as a Central and GATT Client device). 

Two example projects demonstrate this functionality on two different devices:

■ PSoC_4_BLE_OTA works with the CY8CKIT-143A PSoC 4 BLE 256KB Module

■ PRoC_BLE_OTA works with the CY5676A PRoC BLE 256KB Module

The CY5677 CySmart BLE 4.2 USB Dongle is required for this project.

The following features are demonstrated:

■ Over-the-Air (OTA) device firmware upgrade using BLE as the communication link

■ Link Layer Data Length Extension (DLE) in Bluetooth 4.2 

■ Security implementation in Bluetooth 4.1 and Low Energy (LE) Secure Connection in Bluetooth
4.2
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4.6.1.1 Over-the-Air (OTA) Device Firmware Upgrade

The project supports firmware upgrade over-the-air using BLE as the communication link. In other
words, a new application can be downloaded to the device over BLE. 

The project is designed to support firmware upgrade of both the BLE stack and the BLE application.
Thus, the user can update the BLE functionality such as profile implementation and can also update
the core stack itself. To enable this feature, the workspace is divided into multiple projects:

■ Launcher project – responsible for launching either the stack project or the application project. If 
the stack project has downloaded a new stack image, the launcher replaces the current stack 
image with the new stack image.

■ Stack project – holds the BLE stack and a custom service for bootloader. It can download a new 
image for either the application or the stack itself.

■ Application project – the BLE profile to be run on the device. It reuses the stack from the stack 
project to avoid duplication of the BLE stack in flash memory. 

The device runs the application project for normal operation. When required to update the applica-
tion or stack image, the device shall switch to the stack project and download a new image. The
steps required to download a new image are as follows:

1. When downloading a new application image:

a. Stack project advertises and connects to a Central device.

b. Central device sends the new application image to the stack project.

c. Stack project overwrites the original application image with the new application image.

d. The device resets.

e. The new application starts.

2. When downloading a new stack image:

a. Stack project advertises and connects to a Central device.

b. Central device sends the new stack image to the stack project.

c. Stack project overwrites the original application image with the new stack image.

d. The device resets.

e. The Launcher project copies the new stack image to overwrite the current stack image.

f. The device resets.

g. The new stack project advertises again and connects to a Central device.

h. Central device sends the new application image to the stack project.

i. Stack project overwrites the application area with the new application image.

j. The device resets.

k. The new application starts.

This OTA architecture is called the Upgradable Stack OTA Bootloader, because the BLE stack itself
can be upgraded. Refer to AN97060 – PSoC 4 BLE and PRoC BLE - Over-the-Air (OTA) Device
Firmware Upgrade (DFU) Guide for more details.

4.6.1.2 Link layer Data Length Extension (DLE)

Bluetooth Special Interest Group (SIG) has introduced a new feature called the Link Layer Data
Length Extension in Bluetooth 4.2 specification. This feature increases the maximum packet size at
the Link Layer to 251 bytes. Until Bluetooth 4.1, this was limited to 27 bytes. Due to this upgrade, the
Link Layer can send larger packets in one transmission; this reduces the overhead of sending packet
headers and switching the radio between transmit and receive states.
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In this project, the original application uses Link Layer packet size of 27 bytes and the new applica-
tion upgrades it to 251 bytes.

4.6.1.3 Security implementation in Bluetooth 4.1 and Low Energy (LE) Secure Connection in 
Bluetooth 4.2

Bluetooth SIG has introduced another new feature called the Low Energy Secure Connection in
Bluetooh 4.2 specification. This feature improves the security implementation over Bluetooth 4.1, by
using an asymmetrical key-pair mechanism called the Elliptic Curve Diffie-Hellman (ECDH). The
ECDH mechanism has a much higher number of key-pair combinations possible compared to earlier
security mechanisms, which makes brute force attacks exponentially difficult to succeed. In this
example project, the usage of the ECDH mechanism is similar to the earlier security mechanism,
where the user enters a passkey shown on the peer device.

This project implements the Bluetooth 4.1 security with Authenticated Encryption in the original
application. In the new application, Bluetooth 4.2 LE Secure Connection is used. 

4.6.2 Project Details

There are a total of four projects in the workspace for this example project:

■ Launcher

■ Stack

■ Original Application

■ New Application

By default, the original application is loaded on the device, and then OTA bootloading to the new
application is shown.

The different parts of this example project are explained in the following sections.

4.6.2.1 GATT Configuration for Application

Both the application projects implement a custom service (called Data Transfer), which includes a
custom characteristic (called Data).

Figure 4-71 shows the GATT configuration for the application projects.

Figure 4-71.  GATT Configuration for the application projects 
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4.6.2.2 GATT Configuration for Stack

The Stack project implements a custom service, which is the Bootloader service. This service
includes a custom characteristic, called the Command characteristic. This characteristic receives the
bootloadable image from the Client. It also sends GATT notifications to confirm that the data was
received properly. The GATT configuration is shown in Figure 4-72.

Figure 4-72.  GATT Configuration for the Stack Project 

4.6.2.3 UART Output to PC Console

All the projects in the workspace have UART output to inform the user about the current state of the
device. This includes information about the current project running on the device, and whether the
device is advertising or connected.

4.6.2.4 Link Layer Data Length Extension (DLE)

DLE can be enabled or disabled simply by changing the BLE component customizer. The original
application project has DLE disabled, while the new application project enables it.

To enable DLE, open the BLE component customizer and navigate to GAP Settings tab. On the
General node, select the appropriate value for Link layer max TX payload size (bytes) and Link
layer max RX payload size (bytes). If these values are more than 27, the DLE feature is enabled.
Figure 4-73 shows the BLE component customizer for DLE.
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Figure 4-73.  Data Length Extension in BLE Component Customizer

4.6.2.5 Security Implementation

The original application project implements Authenticated Pairing with Encryption, where the device
displays a passkey on the UART output, and the user needs to enter that passkey on CySmart. On
entering the passkey, the connection is encrypted. Then the GATT transactions can happen.

The new application project implements Authenticated LE Secure Connections pairing with Encryp-
tion, which works similar to that of the original application. Again, the device displays a passkey
which the user needs to enter on CySmart. On entering the passkey, the connection is encrypted
and then GATT transactions can happen. However, despite the working being the same, this is more
secure because the ECDH mechanism is used to generate keys.

Figure 4-74 and Figure 4-75 show the security implementation of the original application and the
new application, respectively. The stack project also implements Authenticated LE Secure Connec-
tions pairing with Encryption.
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Figure 4-74.  Security Implementation in Original Application

Figure 4-75.  LE Secure Connection in New Application

4.6.2.6 Custom Linker Scripts

Custom linker scripts are used by the project to ensure that the application project can reuse the
BLE stack from the stack project. There are two linker scripts – one for ARM-GCC compiler and
another for ARM-MDK compiler. The ARM-GCC linker script is called cm0gcc.Id and the ARM-MDK
linker script is called Cm0Mdk.scat. These files are located in the LinkerScripts folder of the origi-
nal application and the new application projects. The linker scripts are used in the Build Settings for
these projects. To open Build Settings, click the application project name in the Workspace
Explorer and then go to Project > Build Settings.
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Refer to AN97060 – PSoC 4 BLE and PRoC BLE - Over-the-Air (OTA) Device Firmware Upgrade
(DFU) Guide more details.

4.6.2.7 LED and User Switch

The RGB LED on the BLE Pioneer Baseboard is used to indicate the status of the device. 

Blinking red LED indicates that the device is advertising in the Original Application project. Similarly,
blinking blue LED indicates a New Application project, and blinking green LED indicates a Stack
project. When the device is connected, the RGB LED is turned off.

The user switch (SW2) on the BLE Pioneer Baseboard is used to switch between the Stack project
and the Application project. When the device is running the Application project, pressing SW2 resets
the device and starts the Stack project instead. When the device is running the Stack project, press-
ing SW2 resets the device and starts the Application project.

4.6.2.8 Schematic

The schematic for the Launcher, Stack, Original Application, and New Application projects are
shown in the following figures.

Figure 4-76.  TopDesign for PSoC_4_BLE_OTA_Launcher Project 

Figure 4-77.  TopDesign for PRoC_BLE_OTA_Launcher Project 
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Figure 4-78.  TopDesign for PSoC_4_BLE_OTA_Stack Project 

Figure 4-79.  TopDesign for PRoC_BLE_OTA_Stack Project 
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Figure 4-80.  TopDesign for PSoC 4 BLE Original and New Application Projects 

Figure 4-81.  TopDesign for PRoC BLE Original and New Application Projects 
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4.6.3 Hardware Connection

No specific hardware connections are required for this project because all connection are hardwired
on the BLE Pioneer baseboard.

Ensure that the correct module is placed on the BLE Pioneer Baseboard corresponding to the proj-
ect being used. PSoC_4_BLE_OTA works with the CY8CKIT-143A PSoC 4 BLE 256KB Module.
PRoC_BLE_OTA works with the CY5676A PRoC BLE 256KB Module.

The pin assignment for the PSoC 4 BLE project are in these files:

■ PSoC_4_BLE_OTA_Launcher.cydwr

■ PSoC_4_BLE_OTA_Stack.cydwr

■ PSoC_4_BLE_OTA_Application_Original.cydwr

■ PSoC_4_BLE_OTA_Application_New.cydwr

The pin assignment for the PRoC BLE project are in these files:

■ PRoC_BLE_OTA_Launcher.cydwr

■ PRoC_BLE_OTA_Stack.cydwr

■ PRoC_BLE_OTA_Application_Original.cydwr

■ PRoC_BLE_OTA_Application_New.cydwr

The UART output has the following configuration:

■ Baud rate: 115200 bps

■ Data bits: 8

■ Stop bits: 1

■ Parity: None

Figure 4-82.  Pin Selection for BLE OTA Launcher Project 

Figure 4-83.  Pin Selection for BLE OTA Stack Project 

Figure 4-84.  Pin Selection for BLE OTA Original Application Project
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Figure 4-85.  Pin Selection for BLE OTA New Application Project

4.6.4 Flow Chart

Figure 4-86 shows the flow chart of the Application projects.

Figure 4-86.  Flowchart 
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4.6.5 Verify Output

The project can be verified using the CySmart Central Emulation Tool and BLE Dongle. First, pro-
gram the project to the device. The following is an example using the PSoC_4_BLE_OTA project.

4.6.5.1 Build and Program

Follow these steps to build and program the project to the CY8CKIT-143A PSoC 4 BLE 256KB Mod-
ule. Similar steps are applicable for the PRoC_BLE_OTA project.

1. Connect the BLE Pioneer Baseboard to one of the USB ports on the computer.

2. Set the Build Configuration in PSoC Creator to Release, as shown in Figure 4-87.

Figure 4-87.  Build Configuration in the PSoC_4_BLE_OTA project

3. Build all the projects one by one. For each project, set it as the Active Project, and then build it. 
See Figure 4-88 to set a project as the Active Project. Build the projects in the following order. To 
build a project, click Build > Build <Project Name>.

a. PSoC_4_BLE_OTA_Launcher

b. PSoC_4_BLE_OTA_Stack

c. PSoC_4_BLE_OTA_Application_Original

d. PSoC_4_BLE_OTA_Application_New
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Figure 4-88.  Setting PSoC_4_BLE_OTA_Launcher as the Active Project

4. In the PSoC Creator Workspace Explorer, right-click the 
PSoC_4_BLE_OTA_Application_Original project and select Set As Active Project.

5. Program the BLE Pioneer Kit with the PSoC_4_BLE_OTA_Application_Original project.

4.6.5.2 CySmart Central Emulation Tool

To verify the project using the CySmart Central Emulation Tool, follow these steps:

Note: Refer CySmart Central Emulation tool to learn how to use the tool.

1. On the computer, with the BLE Pioneer Kit connected, open a UART Console emulator such as 
TeraTerm or PuTTY, with the Baud Rate = 115200 bps, Data Bits = 8, Parity = None, and Stop 
Bit = 1. Connect to the COM port labeled KitProg USB-UART.

2. Connect the CY5677 CySmart BLE 4.2 USB Dongle to one of the USB ports on the computer.

3. Start the CySmart Central Emulation Tool on the computer by going to Start > All Programs > 
Cypress > CySmart <version> > CySmart <version>. You will see a list of BLE Dongles con-
nected to it. If no dongle is found, click Refresh. Select the BLE Dongle and click Connect.

4. Press the Reset switch on the BLE Pioneer Kit. The PC console looks as shown in Figure 4-89. 
At the same time, the device starts advertising, and the red LED starts blinking.
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Figure 4-89.  Console Output - Original Application Advertising

5. In the CySmart Central Emulation Tool, click Start Scan to see the list of available BLE Periph-
eral devices.

6. Double-click the PSoC 4 BLE OTA App Original to connect, or click PSoC 4 BLE OTA App 
Original and then click Connect. The red LED turns off at this point.

7. Click Discover All Attributes to find all the attributes supported.

8. Click Pair to initiate authentication and encryption procedure. A dialog box will appear on 
CySmart tool, asking you to enter a passkey, as shown in Figure 4-90. This passkey is displayed 
on the console output, in Figure 4-91. Enter this passkey and click OK.
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Figure 4-90.  Entering Passkey on CySmart Central Emulation Tool

Figure 4-91.  Console Output - Passkey Displayed

9. After the passkey is entered, the connection is authenticated and encrypted. The console output 
displays this information, and CySmart also shows that the pairing is complete.

10.Press the SW2 button on the BLE Pioneer Kit to switch to the Stack project. The existing connec-
tion is disconnected and the device resets. The green LED starts blinking now, and the console 
output shows that the Stack project is started.
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Figure 4-92.  Console Output - Stack Advertising

11.On the CySmart Central Emulation Tool, click Start Scan again to see the list of available BLE 
Peripheral devices. When the device is listed, click Stop Scan.

12.Click PSoC 4 BLE OTA Bootloader and then click Update Firmware. A dialog box opens which 
asks for the type of firmware update to be done. Select Application only update and click Next.

Figure 4-93.  Selecting OTA Firmware Update Type in CySmart

13.Select the file: PSoC_4_BLE_Application_New.cydsn > CortexM0 > ARM_GCC_493 > Release 
> PSoC_4_BLE_OTA_Application_New.cyacd.

14.Click Update. Note that the stack project has a 10 second inactivity timeout, in which if an OTA 
update is not triggered, the device switches back to the application project. If that happens, you 
can again come back to the stack project by pressing SW2.

15.Before the OTA upgrade happens, the connection is authenticated. The stack project displays a 
passkey (similar to the application project), which you will need to enter in a dialog box in 
CySmart. Enter the same and click OK.
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16.The new application image will be downloaded to the device; when the image is completely 
downloaded, the device will reset. At this point, CySmart shows a dialog box to indicate that the 
download is complete. Click Close.

17.The new application starts advertising, as shown in Figure 4-94. The blue LED will blink this time.

Figure 4-94.  Console Output - New Application Advertising

18.In the CySmart Central Emulation Tool, click Start Scan again to see the list of available BLE 
Peripheral devices.

19.Double-click the PSoC 4 BLE OTA App New to connect, or click PSoC 4 BLE OTA App New 
and then click Connect.

20.Click Discover All Attributes to find all the attributes supported.

21.Click Pair to initiate authentication and encryption procedure. Again, a dialog box will appear on 
CySmart tool, asking you to enter a passkey. This passkey is displayed on the console output. 
Enter this passkey and click OK.

22.After the passkey is entered, the connection is authenticated and encrypted. The console output 
displays this information, and CySmart also shows that the pairing is complete.

You can revert to the original application image by pressing the SW2 button on the BLE Pioneer Kit
to switch to the Stack project, and then downloading the original application image.

This project also enables you to update the BLE stack itself. To achieve that, press the SW2 button
on the BLE Pioneer Kit to switch to the stack project. Download the new stack image first from
CySmart, followed by the new application image. For more details, refer to AN97060 – PSoC 4 BLE
and PRoC BLE - Over-the-Air (OTA) Device Firmware Upgrade (DFU) Guide.

4.7 BLE Dongle and LED Control

4.7.1 Project Description

This firmware supports the CySmart debug tool (refer CySmart Central Emulation Tool) by acting as
the BLE host emulator. This is the default firmware that comes in the BLE Dongle shipped with the
kit.
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This project additionally demonstrates LED brightness control via a custom BLE profile, which works
with the CapSense slider example explained in CapSense Slider and LED on page 41. 

The device will scan for the Peripheral, which acts as a CapSense slider and LED device, and
connect to it automatically. This is achieved by filtering the advertisement packets for the CapSense
slider service data. Then, it will enable slider notifications and process the received notifications.
Whenever CapSense detects activity, it will notify the finger location to the BLE Dongle; it will update
the LED brightness using PWM.

The custom GATT client LED control will be stopped if the CySmart Central Emulation Tool acquires
the dongle. The dongle will enter the CySmart emulator mode, in which it will process all BLE
commands as triggered by the user via the tool. The project uses custom command/event protocol
to exchange data between the CySmart Central Emulation Tool and the BLE device via a USB-CDC
interface. It uses the Cypress USB-UART bridge functionality from the PSoC 5LP-based KitProg
module.

Note: This project is meant only for the PRoC BLE device and works on the dongle hardware.

Figure 4-95.  Top Design for BLE_Dongle_CySmart Project 

4.7.2 Hardware Connections

No specific hardware connections are required for this project because all connections are
hardwired on the BLE Dongle.

The pin assignment for this project is in BLE_Dongle_CySmart.cydwr in the Workspace Explorer,
as shown in Figure 4-96.
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Figure 4-96.  Pin Selection for BLE Dongle Project
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4.7.3 Flow Chart

Figure 4-97.  Flow Chart for BLE_Dongle_CySmart Project 
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4.7.4 Verify Output

This project will be used when the CySmart Central Emulation Tool is invoked for testing other
example projects. In addition, the LED control operation can be verified as follows.

1. Power the BLE Pioneer kit through the USB connector J13.

2. Program the BLE Pioneer kit with the CapSense and LED example project described in
CapSense Slider and LED on page 41.

3. Connect the BLE Dongle to one of the USB ports on the computer.

4. Program the BLE Dongle with the BLE_Dongle_CySmart project. See Using Example Projects
on page 37 for programming instructions.

5. Press the user button SW2 on both the BLE Dongle and the BLE Pioneer Kit. The BLE Dongle
will start scanning and the BLE Pioneer Kit will start advertising.

6. Wait for the BLE connection between the BLE Dongle and the BLE Pioneer Baseboard. The con-
nection success status will be indicated by a 3-second ON state of the red LED followed by the
OFF state on the BLE Pioneer Baseboard.

7. Swipe your finger on the CapSense slider and check the LED brightness variation on the BLE
Dongle.

4.8 Direct Test Mode (DTM)

4.8.1 Project Description

Bluetooth Core specification (v4.0 and later), Volume 6, Part F defines Direct Test Mode (DTM) as a
method to test the BLE PHY layer and provide a report back to the tester. It uses a Host Controller
Interface (HCI) with a two-wire UART as the communication protocol.

The Device Under Test (DUT) is the BLE system that is to be tested (for example, BLE Pioneer Kit).
With DTM, the RF performance of the BLE system can be verified during development or on a pro-
duction line. The environment consists of the DUT and a tester. The tester has two parts; the upper
tester sends commands through the HCI and the lower tester performs the corresponding action
over the RF link. The tester compares the command sent over the HCI and the response received
over RF, and provides a result of the performance.

Figure 4-98.  Direct Test Mode (DTM) Setup

The BLE Component allows configuring the device in DTM by enabling the HCI. The appropriate
responses to commands from the tester are performed by the BLE protocol stack and does not
involve separate application handling. The only task required are to start the BLE Component and
call the API to process the events.

DUT

Upper 
Tester

Lower 
Tester

RF (2.4 GHz)

HCI/UART



CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *G 103

Example Projects

The HCI is enabled in the BLE Component under the General settings. Note that when the HCI
mode is selected, all other tabs are hidden and cannot be configured. This is because in HCI mode,
there are no upper layer processes. On enabling HCI mode in the components, the components
automatically reserves a UART block to allow communication between the tester and BLE stack.
The UART exposes the pins that can be assigned in <project.cydwr> file under the Pins tab. The
only options to be configured for HCI mode are the baud rate and the pins for communication with
the tester.

Figure 4-99.  HCI Mode in BLE Component

Many companies develop BLE testers for Direct Test Mode. It is also possible to create PC-based
software tools that will send HCI commands over serial communication links.

For PC-based software, the serial communication link is the COM port, which is enumerated by the
KitProg on the PSoC 5LP of the BLE Pioneer kit. In such a case, the UART pins on the PSoC 4 BLE/
PRoC BLE should be assigned to P1_4 and P1_5. These pins are hardwired to pins on the PSoC
5LP which allows USB-UART data communication between the PC-based software and the BLE
device.

For external BLE testers, the serial communication is mostly over RS232. To test with that type of
system, an external RS232 voltage translator is required, such as Digilent's PmodRS232. This
translator will modify the signal levels of the serial communication between the BLE device and the
RS232 port on the tester. The UART pins of the BLE device can be assigned to P0_0 and P0_1 and
header J5 can be used to connect to the RS232 translator.
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Figure 4-100.  J5 Header to Interface RS232 Translator

4.8.2 Hardware Connection

For DTM test mode, it is recommended to use SMA connectors and connect the tester and DUT
using an SMA to SMA connector cable. This ensures that there is minimum interference to RF
communication between the DUT and tester, and the performance measured is the true RF
performance of the device. The BLE Pioneer Kit module with SMA connector (CY8CKIT-141 PSoC 4
BLE) is available separately and can be ordered from the Cypress web page.

Four UART pins are exposed when HCI mode is selected in the BLE Component. These pins should
be assigned to allow communication with the external tester. The connection depends on the tester
being used.

If the tester is PC-based software that communicates with HCI over a serial link, then the onboard
PSoC 5LP on the BLE Pioneer Kit can act as the USB-UART bridge. The KitProg on the PSoC 5LP
enumerates as a USB-UART interface and opens a COM port on the computer. This COM port is
then used by the software tool to communicate commands to the BLE device. In this case, the UART
pins should be assigned as follows. 

The UART for HCI communication exposes hardware flow control lines CTS and RTS. They can
either be connected to the hardware control lines of the tester or CTS connected to ground for oper-
ation without hardware flow control.

If the tester is an external hardware tester (CBT), then connect any of the RS232 voltage translators
to header J5 on the BLE Pioneer Kit. The UART pins should be assigned as follows.

Table 4-1.  UART Pin Assignment for PC Software Tester

UART Pins Pin Assigned

RX P1_4

TX P1_5

RTS P1_6

CTS P1_7
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4.8.3 Verify Output

1. Connect the BLE Pioneer Kit through the USB connector J13.

2. Program the BLE Pioneer Kit with the PSoC_4_BLE_DTM or PRoC_BLE_DTM project, depend-
ing on the module used (PSoC 4 BLE or PRoC BLE), as described in Using Example Projects on 
page 37. Programming should complete successfully.

3. Connect the serial link, UART, or RS232 to the tester.

4. On the software tool for tester, configure the UART communication with the correct COM port and 
baud rate, as set in the BLE Component.

5. Start the test. The tool will generate the report after the end of the test. This depends on the tes-
ter/tool being used. 

4.9 Migrating Example Projects from 128KB Flash Devices to 256KB 
Flash Devices

All the example projects, except for the OTA project, are designed to support devices with 128KB
flash by default. However, these example projects can also be migrated to work on devices with
256KB flash.

The following table shows the default device used for the example projects provided with the BLE
Pioneer Kit, along with the device that should be used for 256KB flash versions. The modules and
dongles corresponding to these devices are listed in BLE Modules and BLE Dongles Compatible
with the BLE Pioneer Kit chapter on page 149.

Table 4-2.  UART Pin Assignment for RS232 Voltage Translator

UART Pins Pin Assigned

RX P0_0

TX P0_1

RTS P0_2

CTS P0_3
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As an example, the CapSense Slider and LED example project for PSoC 4 BLE supports
CY8C4247LQI-BL483 as the default device. Its migration to the CY8C4248LQI-BL583 device is
shown here:

1. Open the project in PSoC Creator, and navigate to the Workspace Explorer. Right-click the proj-
ect name and choose Device Selector.

Figure 4-101.  Migration Device Selection

2. The Select Device dialog appears. Select the required device and click OK.

Table 4-3.  Device Selector for BLE Pioneer Kit Projects

Project Default Device
Bluetooth 4.1 and 

256KB Flash Version
Bluetooth 4.2 and 

256KB Flash Version

PSoC_4_BLE_CapSense_Slider_LED CY8C4247LQI-BL483 CY8C4248LQI-BL483 CY8C4248LQI-BL583

PSoC_4_BLE_CapSense_Proximity CY8C4247LQI-BL483 CY8C4248LQI-BL483 CY8C4248LQI-BL583

PSoC_4_BLE_Central_IAS CY8C4247LQI-BL483 CY8C4248LQI-BL483 CY8C4248LQI-BL583

PSoC_4_BLE_Eddystone CY8C4247LQI-BL483 CY8C4248LQI-BL483 CY8C4248LQI-BL583

PSoC_4_BLE_OTA CY8C4248LQI-BL583 - CY8C4248LQI-BL583

PSoC_4_BLE_DTM CY8C4247LQI-BL483 CY8C4248LQI-BL483 CY8C4248LQI-BL583

PRoC_BLE_CapSense_Slider_LED CYBL10563-56LQXI CYBL10573-56LQXI CYBL11573-56LQXI

PRoC_BLE_CapSense_Proximity CYBL10563-56LQXI CYBL10573-56LQXI CYBL11573-56LQXI

PRoC_BLE_Central_IAS CYBL10563-56LQXI CYBL10573-56LQXI CYBL11573-56LQXI

PRoC_BLE_Eddystone CYBL10563-56LQXI CYBL10573-56LQXI CYBL11573-56LQXI

PRoC_BLE_OTA CYBL11573-56LQXI - CYBL11573-56LQXI

PRoC_BLE_DTM CYBL10563-56LQXI CYBL10573-56LQXI CYBL11573-56LQXI

BLE_Dongle_Peripheral_IAS CYBL10162-56LQXI - CYBL11573-56LQXI

BLE_Dongle_CySmart CYBL10162-56LQXI - CYBL11573-56LQXI
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Figure 4-102.  Select Device Dialog Box

3. The project now supports the CY8C4248LQI-BL583 device. Build and program the project to the 
new device using the steps in the section Programming using PSoC Creator on page 29.
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This chapter describes the contents of the BLE Pioneer Kit hardware and its different blocks, such as
the power block, USB connection, Arduino-compatible headers, module connectors, and CapSense
slider.

The schematic and board layouts are available at the following location:
<Install_Directory>\Cypress\CY8CKIT-042-BLE Kit\<version>\Hardware.

5.1 BLE Pioneer Baseboard

5.1.1 PSoC 5LP

An onboard PSoC 5LP contains the KitProg, which is used to program and debug the BLE device.
The PSoC 5LP connects to the USB port of the computer through a USB Mini-B connector and to
the SWD interface of the BLE device. PSoC 5LP is a true system-level solution providing MCU,
memory, analog, and digital peripheral functions in a single chip. The CY8C58LPxx family offers a
modern method of signal acquisition, signal processing, and control with high accuracy, high
bandwidth, and high flexibility. The analog capability spans the range from thermocouples (near DC
voltages) to ultrasonic signals.

For more information, visit the PSoC 5LP web page.

See Serial Interconnection between KitProg and Module on page 124 for more details.

5.1.2 Power System

The power supply system on the BLE Pioneer Baseboard is versatile, allowing the input supply to
come from the following sources:

■ 5-V power from the onboard USB connector

■ 5-V to 12-V VIN power from the Arduino power header (J1)

■ 3-V from the CR2032 coin cell
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An adjustable LDO is used to output three different voltage levels (1.9 V, 3.3 V, and 5 V) to power the
module. These voltages are selected with the J16 jumper, as shown in Figure 5-1.

Figure 5-1.  Schematics and Board Highlight of LDO and Power Selection Jumper

The input to the LDO can come from either the USB, the VIN pin in the Arduino header J1, or header
J9.

Note: The typical dropout voltage of the selected LDO is 0.3 V at 500-mA output current. This gives
a minimum output of 4.6 V from the input voltage of 5 V from the VBUS. This drop also considers the
voltage drop across the Schottky diode connected at the output of the LDO to protect against voltage
applied at the output terminal of the regulator.
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The BLE Pioneer Baseboard also contains a CR2032 coin cell holder to power it using a coin cell, as
shown in Figure 5-2.

Figure 5-2.  Schematics and Board Highlight of Coin Cell Holder

5.1.2.1 Protection Circuits

The power supply rail has reverse-voltage, overvoltage, short circuits, and excess current protection
features, as shown in Figure 5-3.

Figure 5-3.  Power Supply Block Diagram With Protection Circuits

■ A PTC resettable fuse is connected to protect the computer's USB ports from shorts and
overcurrent.

■ ORing diodes prevent damage to components when the BLE Pioneer Baseboard is powered
from different voltage sources at the same time.

■ ESD protection is provided for the USB Mini-B connector.
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■ A MOSFET-based protection circuit is provided for overvoltage and reverse-voltage protection for
the 3.3-V rail from J1.5, as shown in Figure 5-4. 

Figure 5-4.  Schematics and Board Highlight of MOSFET Protection Circuit for 3.3-V Rail from J1.5

VDDV3.3
NO LOAD

R9
10K

R8
15K

Q2

PMOS( NTR4171PT1G) 

R7 ZERO

D9
V

z=
3.

9V
(B

Z
T

52
C

3V
9-

7-
F

)

Q3

PMOS(PMV48XP,215)

Q1

P
M

O
S

( D
M

P
3098L-7)



CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *G 112

Hardware

5.1.2.2 Current Measurement Jumper

To demonstrate the low power consumption of PSoC 4 BLE/PRoC BLE Module, a two-pin header
(J15) is populated in series with the power supply to the module. This can be used to measure cur-
rent using an ammeter without the need to desolder any component from the BLE Pioneer Base-
board, as shown in Figure 5-5. 

Figure 5-5.  Schematics and Board Highlight of Current Measurement Jumper
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The following methods are supported for measuring the current consumption of the module. 

■ When the BLE Pioneer Baseboard is powered through the USB port (J13), remove jumper J15
and connect an ammeter, as shown in Figure 5-6.

Figure 5-6.  Current Measurement when Powered from USB Port
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■ When the BLE Pioneer Baseboard is powered from an external voltage supply, remove the USB
cable from J13. Connect the positive terminal of the external voltage supply to the positive termi-
nal of the ammeter and the negative terminal of the ammeter to the upper pin of J15. Connect the
negative terminal of the external voltage supply to an onboard GND pin. Figure 5-7 shows the
required connections.

Figure 5-7.  Current Measurement when Powered Separately

To measure the power consumption of only the module with coin cell, connect the coin cell directly to
the modules, as shown in Figure 5-8. The BLE Pioneer Baseboard is designed with additional
circuits to protect the BLE device and the F-RAM in an Arduino environment. Note that power
consumption measurements on the BLE Pioneer Baseboard will also include the power consumed
by these additional circuits. 

Connect the positive terminal of the coin cell to pin J2.2 and negative terminal to pin J2.4 using
wires.

VOLTAGE
SOURCE

- +
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Figure 5-8.  Powering the Module using a Coin Cell

5.1.3 Programming Interface

The BLE Pioneer Kit allows you to program and debug the PSoC 4 BLE/PRoC BLE in two ways:

■ Using the onboard KitProg 

■ Using a CY8CKIT-002 MiniProg3 programmer and debugger 

5.1.4 Expansion Connectors

5.1.4.1 Arduino-Compatible Headers (J1, J2, J3, J4, and J12-unpopulated)

The BLE Pioneer Kit has five Arduino-compatible headers: J1, J2, J3, J4, and J12, as shown in
Figure 5-9. You can develop applications based on the Arduino shield's hardware.

Figure 5-9.  Arduino Headers

The J1 header contains I/O pins for reset, I/O reference voltage (IOREF), and power supply line. The
J2 header is an analog port that contains I/O pins for SAR ADC, comparator, and opamp. The J3
header is primarily a digital port that contains I/O pins for PWM, I2C, SPI, and analog reference. The
J4 header is also a digital port that contains I/O pins for UART and PWM. The J12 header is an
Arduino ICSP-compatible header for the SPI interface and is not populated. Refer to the “No Load
Components” section of Bill of Materials (BOM) on page 137 for the header part number. 

Arduino 
compatible 
I/O header 
(J3/J4)

Arduino-
compatible 
I/O header 
(J3/J4)

Arduino-
compatible 
I/O header 
(J2)

Arduino-
compatible 
power 
header (J1)
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Note: Take care when powering the Arduino shields via Arduino-compatible power header (J1). The
V3.3 pin will output 5 V when the board is powered from USB/VIN and the system power supply
jumper (J16) is set to 5 V operation. 

Additional Functionality of Header J2

The J2 header is a 6×2 header that supports Arduino shields. The Port 2 and Port 3 pins of
PSoC 4BLE and PRoC BLE are brought to this header. The Port 2 pins also connect to the onboard
CapSense slider through 560-ohm resistors. When the CapSense feature is not used, remove these
resistors to help ensure better performance with these pins. 

5.1.4.2 Pmod Connector - Digilent Pmod Compatible (J5-unpopulated)

This port supports Digilent Pmod modules (see Figure 5-10). Pmods are small I/O interfaces that
connect with the embedded control boards through either 6- or 12-pin connectors. The BLE Pioneer
Kit supports the 6-pin Pmod Type 2 (SPI) interface. For Digilent Pmod cards, go to
www.digilentinc.com.

This header is not populated on the BLE Pioneer Baseboard. You must populate this header before
connecting the Pmod daughter cards. Refer to the “No Load Components” section of Bill of Materials
(BOM) on page 137 for the header part number.

Figure 5-10.  Schematics and Board Highlight of Pmod Connector

Digilent Pmod-
compatible I/O 
header (J5)
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5.1.4.3 PSoC 5LP GPIO Header (J8)

An 8×2 header is provided on the BLE Pioneer Baseboard to pull out several pins of PSoC 5LP to
support advanced features such as a low-speed oscilloscope and a low-speed digital logic analyzer
(see Figure 5-11). This header also contains the USB-Serial interface pins that can be used when
these pins are not accessible on the Arduino headers because a shield is connected.

Note: You can use PSoC 5LP for your own custom firmware. 

Figure 5-11.  Schematics and Board Highlight of PSoC 5LP GPIO Expansion Header
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5.1.5 USB Mini-B Connector

The PSoC 5LP connects to the USB port of a computer through a Mini-B connector (see
Figure 5-12), which can also be used to power the BLE Pineer Baseboard. A resettable polyfuse is
used to protect the computer's USB ports from shorts and overcurrent. If more than 500 mA is drawn
from the USB port, the fuse will automatically break the connection until the short or overload is
removed.

Figure 5-12.  Schematics and Board Highlight of USB Mini-B Connector
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5.1.6 CapSense Circuit

5.1.6.1 CapSense Slider

The BLE Pioneer Kit has a five-segment linear capacitive touch slider, which is connected to the
PSoC 4 BLE/PRoC BLE Module pins (see Figure 5-13). The CMOD and CTANK capacitors are
required for CapSense functionality and are provided on the modules (see Module Board on
page 126). A 2.2-nF capacitor is present on the CMOD pin, P4[0], for CapSense operation. BLE
Pioneer Kit also supports CapSense designs that enable waterproofing. The connection of the shield
to the pin or to ground is made by resistors R12 and R13, respectively. By default, R13 is mounted
on the BLE Pioneer Baseboard, which connects the shield to ground. Populate R12 and remove R13
when evaluating waterproofing designs, which will connect the shield to the designated pin, P1[6].

Figure 5-13.  Schematics and Board Highlight of CapSense Slider and Shield Setting

5.1.6.2 Proximity Header

The BLE Pioneer Baseboard contains a header (J14) for CapSense proximity wire connection (see
Figure 5-14).
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Figure 5-14.  Schematics and Board Highlight of Proximity Header

5.1.7 BLE Pioneer Baseboard LEDs

The BLE Pioneer Baseboard has three LEDs. A green LED (LED2) indicates the status of the pro-
grammer. An amber LED (LED1) indicates the status of power supplied to the board. The BLE Pio-
neer Kit also has a general-purpose tricolor LED (LED3) for user applications. These are connected
to P2_6 (red LED), P3_6 (green LED) and P3_7 (blue LED). Figure 5-15 and Figure 5-16 show the
schematics of these LEDs.

Figure 5-15.  Schematics of Status and Power LED
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Figure 5-16.  Schematics and Board Highlight of RGB LED
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5.1.8 Push-Buttons

The BLE Pioneer Baseboard contains a reset push-button and a user push-button, as shown in
Figure 5-17. The reset button is connected to the XRES pin of BLE device and is used to reset it.
The user button is connected to P2[7] of the BLE device. Both the buttons connect to ground on acti-
vation (active low).

Figure 5-17.  Schematics and Board Highlight of Reset Button and User Button
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5.1.9 Cypress Ferroelectric RAM (F-RAM)

The BLE Pioneer Baseboard contains the FM24V10-G F-RAM device (see Figure 5-18), which can
be accessed through I2C lines P5[0] and P5[1] of the PSoC 4 BLE/PRoC BLE Module. The F-RAM is
1-Mbit (128KB) with an I2C speed up to 1 Mbps. The I2C slave address of the F-RAM device is
seven bits wide, and the LSB two bits are configurable through physical pins and are hardwired to 00
on the board. By default, the address of the F-RAM device used on the BLE Pioneer Baseboard is
0x50. This address can be modified by changing the R32/R36 and R33/R37 pairs. The operating
voltage range of the F-RAM is between 2 V and 3.6 V. To prevent the application of 5 V from the
adjustable LDO regulator on the BLE Pioneer Baseboard, a MOSFET-based protection circuit
similar to the one used for the 3.3-V rail is connected between the output of the regulator and the
VDD pin of the F-RAM. The protection circuit cuts off the power to the F-RAM when the output of the
regulator is greater than 3.6 V.

Figure 5-18.  Schematics and Board Highlight of F-RAM
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5.1.10 Serial Interconnection between KitProg and Module

The KitProg is also a USB-Serial interface. It supports USB-UART and USB-I2C bridges (see
Figure 5-19). The pull-up resistors on the I2C bus are enabled when the protocol is selected from the
user interface (such as Bridge Control Panel). The USB-Serial pins of the KitProg are also available
on the Arduino header; therefore, it can be used to control Arduino shields with the SPI/I2C/UART
interface. Refer USB-UART Bridge on page 34 and USB-I2C Bridge on page 35 for more information
on how to use these serial interconnections. 

Figure 5-19.  Schematics and Board Highlight of Serial Interface and I2C Pull-Up via FET
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5.1.11 Module Headers

The PSoC 4 BLE and PRoC BLE Modules are connected to the BLE Pioneer Baseboard using the
two (24-pin and 20-pin) module headers, as shown in Figure 5-20. 

Figure 5-20.  Schematics and Board Highlight of Module Headers

For information on how to add these on your own board, refer to Adding BLE Module-Compatible
Headers on Your Baseboard on page 147. 
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5.2 Module Board

5.2.1 PSoC 4 BLE or PRoC BLE Device

The PRoC BLE or PSoC 4 BLE device is the main component on the module. It provides the RF
interface and analog and digital capability. The PRoC BLE or PSoC 4 BLE pins are mapped to the
module headers (see Figure 5-21). For more information, refer to the BLE web page.

See BLE Modules and BLE Dongles Compatible with the BLE Pioneer Kit on page 149 for details.

Figure 5-21.  Schematics and Board Highlight of Module Headers for BLE Pins 
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5.2.2 Module Power Connections

The module has three power domains: VDDD, VDDA, and VDDR. The VDDD connection supplies
power for digital device operation, VDDA supplies power for analog device operation, and VDDR
connection supplies power for the device radio. By default, these domains are shorted using a 
330-ohm, 100-MHz ferrite bead. The domains are shorted for standalone usage scenarios of mod-
ule, such as programming the module using MiniProg 3 or using the module as a standalone data
acquisition unit.

It is recommended to place the ferrite bead between the supply to avoid ripple between VDDR and
the other two domains. If the supply ripple is less that 100 mV, these can be changed to a zero-ohm
resistor.

Figure 5-22.  Schematics and Board Highlight of Ferrite Bead and Power Pin

5.2.3 Module Headers (20-Pin and 24-Pin Headers)

The PSoC 4 BLE and PRoC BLE Modules connect to the BLE Pioneer Baseboard using two (20-pin
and 24-pin) module headers (Figure 5-23). All GPIOs and power domains are brought out to these
headers. These headers are the counterparts of the connectors in Expansion Connectors on
page 115.
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Figure 5-23.  Schematics and Board Highlight of Headers
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5.2.4 Wiggle Antenna

Both the modules use the wiggle antenna. Refer to the Antenna Design Guide (AN91445) for details.

Figure 5-24.  Board Highlight of Wiggle Antenna
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5.2.5 Antenna Matching Network

An Antenna Matching Network is required between the BLE device and the antenna to achieve opti-
mum performance (Figure 5-25). The matching network has four main tasks:

■ Transform the balanced output of the radio to an unbalanced connection to the antenna (balun). 

■ Transform the output impedance of the radio to a 50-ohm antenna. 

■ Suppress harmonics to a level below the regulations level in TX mode. 

■ Suppress the local oscillator (LO) leakage in RX mode.

Figure 5-25.  Schematics and Board Highlight of Antenna Matching Network and Antenna
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5.2.6 BLE Passives

Module boards include a 24-MHz crystal and a 32-kHz crystal, the CMOD and shield (CTANK) cir-
cuit for CapSense, a SAR bypass capacitor, and adequate decoupling capacitors for all the power
domains, as shown in Figure 5-26.

Figure 5-26.  Schematics and Board Highlight – External Crystal, CMOD, CTANK, Decaps, Jumpers 
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5.2.7 Test Points

All power domains are brought out as test points for easy probing. 

5.3 BLE Dongle Board

See PSoC 4 BLE or PRoC BLE Device on page 126 for schematics of PRoC BLE pins. 

See Wiggle Antenna on page 129 for schematics of wiggle antenna.

See Antenna Matching Network on page 130 for schematics of antenna matching network.

See BLE Pioneer Baseboard LEDs on page 120 for schematics of power and status LED.

See Push-Buttons on page 122 for schematics of push-buttons.

Figure 5-27.  Board Highlight 
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5.3.1 Power System

The BLE Dongle is powered directly using 5 V from the USB port, as shown in Figure 5-28.

Figure 5-28.  Power Supply Block Diagram With Protection Circuits

5.3.1.1 Protection Circuits

The PTC resettable fuse is connected to protect the computer's USB ports from shorts and overcur-
rent.

5.3.2 USB Type-A Plug

The KitProg on the BLE Dongle connects to the USB port of a computer through a USB Type-A plug
(Figure 5-29). The BLE Dongle is powered using the same plug. A resettable polyfuse is used to pro-
tect the computer's USB ports from shorts and overcurrent. If more than 500 mA is applied to the
USB port, the fuse will automatically break the connection until the short or overload is removed. The
VBUS, D+, and D– lines from the USB connector are also protected against ESD events using TVS
diodes.

Figure 5-29.  Schematics and Board Highlight of USB Type-A Plug
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5.3.3 User LED

A user LED is provided to indicate status from the PRoC BLE device (Figure 5-30). It is also used to
show the bind status.

Figure 5-30.  Schematics and Board Highlight of User LED
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This chapter describes the functionality of the FM24V10 F-RAM in the BLE Pioneer Kit.

6.1 Using FM24V10 F-RAM

The BLE Pioneer Baseboard has an onboard ferroelectric RAM chip that can hold up to 1 Mb of
data. The chip provides an I2C communication interface for data access. It is hardwired to the I2C
lines (P5_0 and P5_1). Because the F-RAM device is an I2C slave, it can be accessed or shared
among various I2C masters on the same line. For more details on the F-RAM device, refer to the
device datasheet.

6.1.1 Address Selection

The slave address of the F-RAM device consists of three parts, as shown in Figure 6-1: slave ID,
device select, and page select. Slave ID is an F-RAM family-specific ID located in the datasheet of
the particular F-RAM device. For the device used in the BLE Pioneer Baseboard (FM24V10), the
slave ID is 1010b. Device select bits are set using the two physical pins A2 and A1 in the device. The
setting of these two pins on the BLE Pioneer Baseboard is controlled by resistors R32/R36 (A1) and
R33/R37 (A2). Because the memory location in F-RAM is divided into two pages of 64KB each, the
page select bit is used to refer to one of the two pages in which the read or write operations will take
place.

Figure 6-1.  F-RAM I2C Address Byte Structure
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Advanced Topics

6.1.2 Write/Read Operation

The device datasheet includes details on how to perform a write/read operation with the F-RAM.
Figure 6-2 and Figure 6-3 provide a snapshot of the write/read packet structure as a quick reference.

Figure 6-2.  F-RAM Single-Byte and Multiple-Byte Write Packet Structure

Figure 6-3.  F-RAM Single-Byte and Multiple-Byte Read Packet Structure

As shown in the figures, all operations start with the slave address followed by the memory address.
For write operations, the bus master sends each byte of data to the memory, and the memory
generates an acknowledgement condition. For read operations, after receiving the complete slave
address and memory address, the memory begins shifting data from the current address on the next
clock.
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A. Appendix

A.1 Bill of Materials (BOM)

A.1.1 BLE Pioneer Baseboard

Item Qty. Reference Value Description Manufacturer Manufacturer Part No.

1 -

PCB, 106.22 mm x 53.34 
mm, High Tg, ENIG finish, 4 
layer, Color = RED, Silk = 
WHITE.

Cypress

2 1 BT1
CR2032 Bat-
tery Holder

HOLDER COIN CELL 
CR2032 EJECT

MPD BA2032

3 1 C1 1.0 uF
CAP TANT 1UF 35V 10% 
1210

AVX Corporation TAJB105K035RNJ

4 1 C2 4.7 uF
CAP TANT 4.7UF 20V 10% 
1210

AVX Corporation TAJB475K020RNJ

5 1 C3 0.01 uFd
CAP 10000PF 16V 
CERAMIC 0402 SMD

TDK Corporation C1005X7R1C103K050BA

6 1 C4 100 uFd
CAP CER 100UF 6.3V 20% 
X5R 1210

TDK Corporation C3225X5R0J107M250AC

7 15

C5,C8,C9,C10,C1
2,C14,C17,C18,C
19,C21,C23,C25,
C26,C27,C28

0.1 uFd
CAP .1UF 16V CERAMIC 
X5R 0402

TDK Corporation C1005X5R1A104K050BA

8 7
C6,C7,C11,C13,C
15,C16,C20

1.0 uFd
CAP CERAMIC 1.0UF 25V 
X5R 0603 10%

Taiyo Yuden TMK107BJ105KA-T

9 1 C29 33 uF
CAP CER 33UF 6.3V 20% 
X5R 0805

TDK Corporation C2012X5R0J336M125AC

10 6
D1,D2,D3,D4,D5,
D10

MBR0520L
DIODE SCHOTTKY 0.5A 
20V SOD-123

Fairchild Semicon-
ductor

MBR0520L

11 3 D6,D7,D8 ESD diode
SUPPRESSOR ESD 5VDC 
0603 SMD

Bourns Inc. CG0603MLC-05LE

12 1 D9 3.9V Zener
DIODE ZENER 3.9V 500MW 
SOD12

Diodes Inc BZT52C3V9-7-F

13 1 D11 2.7V Zener
DIODE ZENER 2.7V 500MW 
SOD123

ON Semiconductor MMSZ4682T1G

14 1 F1 FUSE
PTC RESETTABLE .50A 
15V 1812

Bourns MF-MSMF050-2

15 2 J1, J4 8x1 RECP 
CONN HEADER FEMALE 
8POS .1" GOLD

Protectron Electro-
mech

P9401-08-21

16 1 J2 6x2 RECP
CONN HEADER FMAL 
12PS.1" DL GOLD

Protectron Electro-
mech

P9403-12-21

17 1 J3 10x1 RECP
CONN HEADER FMALE 
10POS .1" GOLD

Protectron Electro-
mech

P9401-10-21



CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *G 138

18 1 J8 8X2 RECP
CONN HEADER FMAL 
16PS.1" DL GOLD

Protectron Electro-
mech

P9403-16-21

19 1 J10 12X2 RECP
CONN HEADER 2.54MM 
24POS GOLD

Sullins Connector 
Solutions

SBH11-PBPC-D12-ST-BK

20 1 J11 10X2 RECP
CONN HEADER 2.54MM 
20POS GOLD

Sullins Connector 
Solutions

SBH11-PBPC-D10-ST-BK

21 1 J13 USB MINI B MINI USB RCPT R/A DIP TE Connectivity 1734510-1

22 1 J14 1X1 RECP
CONN RCPT 1POS .100" 
SNGL HORZ

Samtec Inc BCS-101-L-S-HE

23 1 J15 2p_jumper
CONN HEADR BRKWAY 
.100 2POS STR

Protectron Electro-
mech

P9101-02-12-1

24 1 J16 3p_jumper
CONN HEADR BRKWAY 
.100 3POS STR

Protectron Electro-
mech

P9101-03-12-1

25 1 LED1
Power LED 
Amber

LED 595NM AMB DIFF 0805 
SMD

Avago Technolo-
gies 

HSMA-C170

26 1 LED2
Status LED 
Green

LED GREEN CLEAR 0805 
SMD

Chicago Miniature CMD17-21VGC/TR8

27 1 LED3 RGB LED
LED RED/GREEN/BLUE 
PLCC4 SMD

Cree, Inc.
CLV1A-FKB-
CJ1M1F1BB7R4S3

28 3 L1,L2,L3
330 OHM @ 
100MHz

FERRITE CHIP 330 OHM 
0805

Murata BLM21PG331SN1D

29 3 Q2,Q4,Q6 PMOS
MOSFET P-CH 30V 2.2A 
SOT23

ON Semiconductor NTR4171PT1G

30 1 Q1, PMOS
MOSFET P-CH 30V 3.8A 
SOT23-3

Diodes Inc DMP3098L-7

31 2 Q3,Q5 PMOS
MOSFET P-CH 20V 3.5A 
SOT23

NXP Semiconduc-
tors

PMV48XP,215

32 1 R1 11K 1%
RES 11K OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF1102V

33 1 R2 560 ohm
RES 560 OHM 1/8W 5% 
0805 SMD

Panasonic - ECG ERJ-6GEYJ561V

34 1 R3 14.7K 1%
RES 14.7K OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF1472V

35 1 R4 10K 1%
RES 10K OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF1002V

36 1 R5 4.3K 1%
RES 4.3K OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF4301V

37 1 R6 100K
RES 100K OHM 1/10W 5% 
0402 SMD

Panasonic - ECG ERJ-2GEJ104X

38 14

R19,R26,R27,R3
6,R37,R38,R45,R
46,R47,R52,R53,
R54,R55,R56

ZERO
RES 0.0 OHM 1/10W 0603 
SMD

Panasonic - ECG ERJ-3GEY0R00V

39 2 R8,R58 15K
RES 15K OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF1502V

40 2 R9,R20 10K 1%
RES 10K OHM 1/8W 1% 
0805 SMD

Stackpole Electron-
ics Inc

RMCF0805FT10K0 

41 1 R10 10K
RES 10K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ103V

42 1 R11 820 ohm
RES 820 OHM 1/8W 5% 
0805 SMD

Panasonic - ECG ERJ-6GEYJ821V

43 2 R13,R14 ZERO
RES 0.0 OHM 1/8W 0805 
SMD

Panasonic-ECG ERJ-6GEY0R00V

Item Qty. Reference Value Description Manufacturer Manufacturer Part No.
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44 2 R15,R16 22E
RES 22 OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF22R0V

45 2 R17,R18 15K
RES 15K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ153V

46 5
R22,R23,R28,R3
1,R35 

2.2K
RES 2.2K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ222V

47 2 R24,R25 30K
RES 30K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ303V

48 2 R29,R30 1.5K
RES 1.5K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ152V

49 5
R39,R40,R41,R4
2,R43

560 ohm
RES 560 OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ561V

50 2 SW1,SW2
SW PUSH-
BUTTON

SWITCH TACTILE SPST-
NO 0.05A 12V

Panasonic - ECG EVQ-PE105K

51 1 TP5 BLACK
TEST POINT PC MINI 
.040"D Black

Keystone Electron-
ics

5001

52 2 TVS1,TVS2 5V 350W
TVS UNIDIR 350W 5V SOD-
323

Dioded Inc. SD05-7

53 1 U1 LDO
IC REG LDO ADJ 1A 
TO252-5

Rohm Semiconduc-
tor

BA00BC0WFP-E2

54 1 U2 PSoC 5LP 
68QFN PSoC 5LP chip for 
USB debug channel and 
USB-Serial interface

Cypress Semicon-
ductor

CY8C5868LTI-LP039

55 1 U3 F-RAM
F-RAM 1-Mbit (128K X 8) 
I2C interface

Cypress Semicon-
ductor

FM24V10-G

56 1 U4 DUAL PMOS
MOSFET 2P-CH 20V 430MA 
SOT-563

ON Semiconductor NTZD3152PT1G

Install on Bottom of PCB As per the Silk Screen in the Corners

57 4 N/A N/A
BUMPER CYLIN 0.375" DIA 
BLK

3M SJ61A4

Special Jumper Installation Instructions

58 2 J15,J16
Install jumper 
across pins 1 
and 2 

Rectangular Connectors 
MINI JUMPER GF  6.0MM 
CLOSE TYPE BLACK

Kobiconn 151-8010-E

Label

59 1 N/A N/A

LBL, PCA Label, Vendor 
Code, Datecode, Serial 
Number 121-60158-01 Rev 
04 (YYWWVVXXXXX)

Cypress Semicon-
ductor

60 1 N/A N/A
LBL, QR code, 12mm X 
12mm

Cypress Semicon-
ductor

No load components

61 1 C22 0.1 uFd
CAP .1UF 16V CERAMIC 
Y5V 0402

TDK Corporation C1005X5R1A104K050BA

62 1 C24 1.0 uFd
CAP CERAMIC 1.0UF 25V 
X5R 0603 10%

Taiyo Yuden TMK107BJ105KA-T

63 9
R7,R59,R32,R33,
R34,R48,R49,R5
0,R51

Zero Ohm
RES 0.0 OHM 1/10W JUMP 
0603

TE Connectivity 1623094-1

64 1 R21 4.7K
RES 4.7K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ472V

Item Qty. Reference Value Description Manufacturer Manufacturer Part No.
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65 2 J7,J6
50MIL KEYED 
SMD

CONN HEADER 10 PIN 
50MIL KEYED SMD

Samtec FTSH-105-01-L-DV-K

66 1 J9 2 PIN HDR
CONN HEADER FEMALE 
2POS .1" GOLD

Sullins Connector 
Solutions

PPPC021LFBN-RC

67 2 TP4,TP5 BLACK
TEST POINT 43 HOLE 65 
PLATED BLACK

Keystone Electron-
ics

5001

68 3 TP1,TP2,TP3 RED
TEST POINT 43 HOLE 65 
PLATED RED

Keystone Electron-
ics

5000

69 2 R44,R12 ZERO
RES 0.0 OHM 1/8W 0805 
SMD

Panasonic-ECG ERJ-6GEY0R00V

70 1 J12 3x2 RECPT
CONN HEADER FMAL 6PS 
.1" DL GOLD

Sullins Connector 
Solutions

PPPC032LFBN-RC

71 1 J5 6X1 RECP RA
CONN FEMALE 6POS .100" 
R/A GOLD

Sullins Connector 
Solutions

PPPC061LGBN-RC

Item Qty. Reference Value Description Manufacturer Manufacturer Part No.
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A.1.2 Module

A.1.2.1 CY5671 PRoC BLE Module

Item Qty. Reference Value Description Manufacturer Manufacturer Part No.

1 1 600-60196-01 -
PRoC BLE Module printed cir-
cuit board 

Cypress qualified ven-
dor 

600-60196-01 Rev03

2 8
C1,C3,C5,C7,C9
,C11,C16,C18

0.1 uF
CAP .1UF 16V CERAMIC Y5V 
0402

Samsung Electro-
Mechanics America, 
Inc

CL05F104ZO5NNNC

3 10
C2,C4,C6,C8,C1
0,C12,C15,C17,
C19,C20

1.0 uF
CAP CERAMIC 1.0UF 25V 
X5R 0603 10%

TDK Corporation C1608X5R1E105K080AC

4 1 C21 2200 pF
CAP CER 2200PF 50V 5% 
NP0 0805

Murata Electronics GRM2165C1H222JA01D

5 1 C22 10000 pF
CAP CER 10000PF 50V 5% 
NP0 0805

Murata Electronics GRM2195C1H103JA01D

6 1 C23 36 pF
CAP CER 36PF 50V 5% NP0 
0402

Murata Electronics GRM1555C1H360JA01D

7 1 C24 18 pF
CAP CER 18PF 50V 1% NP0 
0402

Murata Electronics GRM1555C1H180FA01D

8 1 C14 1.5 pF
CAP CER 1.5PF 50V NP0 
0402

Johanson Technology 
Inc

500R07S1R5BV4T

9 1 J1 Header 24
CONN HEADR FMALE 24POS 
.1" DL AU

Sullins Connector SFH11-PBPC-D12-ST-BK

10 1 J2 Header 20
CONN HEADR FMALE 20POS 
.1" DL AU

Sullins Connector SFH11-PBPC-D10-ST-BK

11 1 L1 6.8nH CER INDUCTOR 6.8NH 0402
Johanson Technology 
Inc

L-07C6N8JV6T

12 3 L2,L3,L4
330 Ohm 
@100MHz

FERRITE CHIP 330 OHM 0805 Murata Electronics BLM21PG331SN1D

13 1 U1 PRoC BLE 56 QFN PRoC BLE 
Cypress Semiconduc-
tor

CYBL10563-56LQXI

14 1 Y1 32.768kHz
CRYSTAL 32.768KHZ 12.5PF 
SMD

ECS Inc ECS-.327-12.5-34B

15 1 Y2 24MHz
CRYSTAL 24.000 MHZ 8PF 
SMD

ECS Inc ECS-240-8-36CKM

16 1 LBL -

LBL, PCA Label, Vendor Code, 
Datecode, Serial Number 121-
60160-01 Rev 04 (YYWWV-
VXXXXX)

Cypress qualified ven-
dor 

-

No Load components

17 1 C13 1.2 pF
CAP CER 1.2PF 50V NP0 
0402

Johanson Technology 
Inc

500R07S1R2BV4T

18 1 C25 100pF
CAP CER 100PF 50V 10% 
X7R 0603

Kemet C0603C101K5RACTU

19 1 R1 Zero Ohm RES 0.0 OHM 1/8W 0605 SMD TE Connectivity 1623094-1

20 1 R2 Rbleed No Load - -
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A.1.2.2 CY8CKIT-142 PSoC 4 BLE Module

21 1 R3 4.7K
RES 4.7K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ472V

22 1 J3 4 HEADER
CONN HEADER 4POS .100 R/
A 15AU

FCI 68016-204HLF

23 4
TP1,TP2,TP3,T
P4

RED
TEST POINT 43 HOLE 65 
PLATED RED

Keystone Electronics 5000

24 1 TP5 BLACK
TEST POINT 43 HOLE 65 
PLATED BLACK

Keystone Electronics 5001

Item Qty. Reference Value Description Manufacturer Manufacturer Part No.

1 1 600-60195-01 -
PSoC 4 BLE Module printed 
circuit board 

Cypress qualified 
vendor 

600-60195-01 Rev03

2 8
C1,C3,C5,C7,C9,C
11,C16,C18

0.1 uF
CAP .1UF 16V CERAMIC Y5V 
0402

Samsung Electro-
Mechanics America, 
Inc

CL05F104ZO5NNNC

3 10
C2,C4,C6,C8,C10,
C12,C15,C17,C19,
C20

1.0 uF
CAP CERAMIC 1.0UF 25V 
X5R 0603 10%

TDK Corporation C1608X5R1E105K080AC

4 1 C21 2200 pF
CAP CER 2200PF 50V 5% 
NP0 0805

Murata Electronics GRM2165C1H222JA01D

5 1 C22 10000 pF
CAP CER 10000PF 50V 5% 
NP0 0805

Murata Electronics GRM2195C1H103JA01D

6 1 C23 36 pF
CAP CER 36PF 50V 5% NP0 
0402

Murata Electronics GRM1555C1H360JA01D

7 1 C24 18 pF
CAP CER 18PF 50V 1% NP0 
0402

Murata Electronics GRM1555C1H180FA01D

8 1 C14 1.5 pF
CAP CER 1.5PF 50V NP0 
0402

Johanson Technol-
ogy Inc

500R07S1R5BV4T

9 1 J1 Header 24
CONN HEADR FMALE 
24POS .1" DL AU

Sullins Connector SFH11-PBPC-D12-ST-BK

10 1 J2 Header 20
CONN HEADR FMALE 
20POS .1" DL AU

Sullins Connector SFH11-PBPC-D10-ST-BK

11 1 L1 6.8nH CER INDUCTOR 6.8NH 0402
Johanson Technol-
ogy Inc

L-07C6N8JV6T

12 3 L2,L3,L4
330 Ohm 
@100 MHz

FERRITE CHIP 330 OHM 
0805

Murata Electronics BLM21PG331SN1D

13 1 U1
PSoC 4 BL
E

56 QFN PSoC 4 BLE 
Cypress Semicon-
ductor

CY8C4247LQI-BL483

14 1 Y1 32.768KHz
CRYSTAL 32.768KHZ 12.5PF 
SMD

ECS Inc ECS-.327-12.5-34B

15 1 Y2 24MHz
CRYSTAL 24.000 MHZ 8PF 
SMD

ECS Inc ECS-240-8-36CKM

16 1 LBL -

LBL, PCA Label, Vendor 
Code, Datecode, Serial Num-
ber 121-60159-01 Rev 04 
(YYWWVVXXXXX)

Cypress qualified 
vendor 

-

No Load components

17 1 C13 1.2 pF
CAP CER 1.2PF 50V NP0 
0402

Johanson Technol-
ogy Inc

500R07S1R2BV4T

Item Qty. Reference Value Description Manufacturer Manufacturer Part No.
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18 1 C25 100pF
CAP CER 100PF 50V 10% 
X7R 0603

Kemet C0603C101K5RACTU

19 1 R1 Zero Ohm
RES 0.0 OHM 1/10W JUMP 
0603

TE Connectivity 1623094-1

20 1 R2 Rbleed No Load - -

21 1 R3 4.7K
RES 4.7K OHM 1/10W 5% 
0603 SMD

Panasonic - ECG ERJ-3GEYJ472V

22 1 J3 4 HEADER
CONN HEADER 4POS .100 
R/A 15AU

FCI 68016-204HLF

23 4 TP1,TP2,TP3,TP4 RED
TEST POINT 43 HOLE 65 
PLATED RED

Keystone Electronics 5000

24 1 TP5 BLACK
TEST POINT 43 HOLE 65 
PLATED BLACK

Keystone Electronics 5001

Item Qty. Reference Value Description Manufacturer Manufacturer Part No.
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A.1.3 BLE Dongle

Item Qty. Reference Value Description Manufacturer Manufacturer Part No.

1 1 600-60197-01 -

PCB, 60 mm x 30 mm, 
High Tg, ENIG finish, 2 
layer, Color = BLACK, 
Silk = WHITE.

Cypress qualified 
vendor 

600-60197-01 Rev02

2 17

C1,C4,C6,C7,C9,C11
,C14,C16,C25,C28,C
29,C32,C35,C36,C38
,C41,C42

0.1 uFd
CAP .1UF 16V 
CERAMIC Y5V 0402

TDK Corporation C1005X5R1A104K050BA

3 17

C2,C3,C5,C8,C10,C
12,C13,C15,C17,C18
,C24,C26,C30,C31,C
33,C34,C40

1.0 uFd
CAP CERAMIC 1.0UF 
25V X5R 0603 10%

Taiyo Yuden TMK107BJ105KA-T

4 1 C19 1.2 pFd
CAP CER 1.2PF 50V 
NP0 0402

Johanson Technology 
Inc

500R07S1R2BV4T

5 1 C22 36 pF
CAP CER 36PF 50V 5% 
NP0 0402

Murata Electronics GRM1555C1H360JA01D

6 1 C23 18 pF
CAP CER 18PF 50V 1% 
NP0 0402

Murata Electronics GRM1555C1H180FA01D

7 1 C39 0.01 uFd
CAP 10000PF 16V 
CERAMIC 0402 SMD

TDK Corporation C1005X7R1C103K050BA

8 3 D1,D2,D3
ESD 
diode

SUPPRESSOR ESD 
5VDC 0603 SMD

Bourns Inc. CG0603MLC-05LE

9 1 F1 FUSE
PTC RESETTABLE 
.50A 15V 1812

Bourns MF-MSMF050-2

10 1 J1
USB 
Type-A 
PLUG

CONN PLUG USB 
4POS RT ANG PCB

Molex Inc 480370001

11 1 J2
50MIL 
KEYED 
SMD

CONN HEADER 10POS 
DUAL SHRD SMD

FCI 20021521-00010T1LF

12 1 LED1
Status 
LED Blue

LED BLUE CLEAR 
THIN 0805 SMD

LiteOn Inc LTST-C171TBKT

13 1 LED2
Status 
LED 
Green

LED GREEN CLEAR 
0805 SMD

Chicago Miniature CMD17-21VGC/TR8

14 1 LED3
Power 
LED Red

LED SUPER RED 
CLEAR 0805 SMD

LiteOn Inc LTST-C170KRKT

15 1 L1 5.1 nH
CER INDUCTOR 5.1NH 
0402

Johanson Technology 
Inc

L-07C5N1SV6T

16 2 R8,R11
Zero 
Ohm

RES 0.0 OHM 1/8W 
0805 SMD

Panasonic-ECG ERJ-6GEY0R00V

17 1 R7 820 ohm
RES 820 OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ821V

18 2 R22,R25 820 ohm
RES 820 OHM 1/8W 5% 
0805 SMD

Panasonic - ECG ERJ-6GEYJ821V

19 2 R9,R10 2.2K
RES 2.2K OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ222V

20 9
R1,R2,R3,R4,R12,R
13,R14,R15,R26

ZERO
RES 0.0 OHM 1/10W 
0603 SMD

Panasonic - ECG ERJ-3GEY0R00V
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21 2 R17,R18 22E
RES 22 OHM 1/10W 1% 
0603 SMD

Panasonic - ECG ERJ-3EKF22R0V

22 1 R21 100K
RES 100K OHM 1/10W 
5% 0402 SMD

Panasonic - ECG ERJ-2GEJ104X

23 2 R19,R20 15K
RES 15K OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ153V

24 2 R23,R24 30K
RES 30K OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ303V

25 2 SW1,SW2
SW RA 
PUSH

SWITCH TACTILE 
SPST-NO 0.05A 12V

Panasonic - ECG EVQ-P3401P

26 1 TVS1 5V 350W
TVS UNIDIR 350W 5V 
SOD-323

Diodes Inc. SD05-7

27 1 U1
PRoC 
BLE

PRoC BLE, Programma-
ble Radio on Chip, 
56QFN

Cypress Semiconduc-
tor

CYBL10162-56LQXI

28 1 U2
DUAL 
PMOS

MOSFET 2P-CH 20V 
430MA SOT-563

ON Semiconductor NTZD3152PT1G

29 1 U3
PSoC 
5LP 

PSoC 5LP Programma-
ble System on Chip, 
68QFN

Cypress Semiconduc-
tor

CY8C5868LTI-LP039

30 1 Y1
32.768K
Hz

CRYSTAL 32.768KHZ 
12.5PF SMD

ECS Inc ECS-.327-12.5-34B

31 1 Y2 24MHz
CRYSTAL 24.000 MHZ 
8PF SMD

ECS Inc ECS-240-8-36CKM

32 1 N/A N/A

LBL, PCA Label, Vendor 
Code, Datecode, Serial 
Number 121-60161-01 
Rev 03 (YYWWV-
VXXXXX); Only barcode

Cypress qualified 
vendor 

-

No load components

33 1 C20 1.2 pF
CAP CER 1.2PF 50V 
NP0 0402

Johanson Technology 
Inc

500R07S1R2BV4T

34 1 C21 100pF
CAP CER 100PF 50V 
10% X7R 0603

Kemet C0603C101K5RACTU

35 1 C37 0.1 uFd
CAP .1UF 16V 
CERAMIC Y5V 0402

TDK Corporation C1005X5R1A104K050BA

36 1 C27 1.0 uFd
CAP CERAMIC 1.0UF 
25V X5R 0603 10%

Taiyo Yuden TMK107BJ105KA-T

37 1 R5
Zero 
Ohm

RES 0.0 OHM 1/10W 
JUMP 0603

TE Connectivity 1623094-1

38 2 R6,R16 4.7K
RES 4.7K OHM 1/10W 
5% 0603 SMD

Panasonic - ECG ERJ-3GEYJ472V

39 15

TP1,TP2,TP3,TP4,T
P5,TP6,TP7,TP8,TP
9,TP10,TP11,TP12,T
P13,TP14,TP15

No load No load - -

Item Qty. Reference Value Description Manufacturer Manufacturer Part No.
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A.2 KitProg Status LED States

User Indication Scenario Action Required by user

LED blinks fast:

Frequency = 4.00 Hz
LED starts blinking at power up, 
if bootloadable file is corrupt.

Bootload the KitProg.cyacd file: In PSoC Programmer, connect to 
the kit, open the Utilities tab, and press the Upgrade Firmware 
button.

LED blinks slow:

Frequency = 0.67 Hz

Entered Bootloader mode by 
holding the Reset button of the 
BLE Pioneer Kit/BLE Dongle 
during kit power up.

Release the Reset button and replug power if you entered this 
mode by mistake. If the mode entry was intentional, bootload the 
new .cyacd file using the Bootloader Host tool shipped with PSoC 
Creator.

LED blinks very fast:

Frequency = 15.0 Hz

SWD operation is in progress.

Any I2C traffic.

Kit's COM port connect/discon-
nect event (one blink).

In PSoC Programmer, watch the log window for status messages 
for SWD operations. In the Bridge Control Panel, the LED blinks 

on I2C command requests. In Bridge Control Panel or any other 
serial port terminal program, distinguish the kit's COM port num-
ber by the blinking LED when the port is connected or discon-
nected.

LED is ON.
USB enumeration successful. 

Kit is in the idle state waiting for 
commands.

The kit functions can be used by PSoC Creator, PSoC Program-
mer, Bridge Control Panel, and any serial port terminal program.

LED is OFF. Power LED is ON.

This means that the USB enumeration was unsuccessful. This 
can happen if the kit is not powered from the USB host or the kit is 
not connected to the USB host through the USB cable. Verify the 
USB cable and check if PSoC Programmer is installed on the PC.
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A.3 Adding BLE Module-Compatible Headers on Your Baseboard

The baseboard should have a 20-pin header and a 24-pin header. Dimension of these connectors
are given here. 

Figure A-1.  Connectors on BLE Pioneer Kit Baseboard

These headers are available for purchase from Digikey. 

Description Manufacturer
Manufacturer Part 

Number
Digikey Part Number

CONN HEADER 2.54MM 
24POS GOLD

Sullins Connector 
Solutions

SBH11-PBPC-D12-ST-BK
SBH11-PBPC-D12-ST-BK-
ND

CONN HEADER 2.54MM 
20POS GOLD

Sullins Connector 
Solutions

SBH11-PBPC-D10-ST-BK S9172-ND

940 mils

740 mils

Pin 1

Pin 1

20 pin header 

24 pin header 
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A.4 Programming BLE Modules via MiniProg3

If the BLE Modules are to be used without the BLE Pioneer Baseboard, they can be programmed
using MiniProg3. The J2 header has five adjacent pins – VDDD, GND, XRES, P0[7], and P0[6].
These pins can be used to program the BLE Module using MiniProg3.

Figure A-2.  Programming a BLE Module via MiniProg3

Follow these steps to program the module:

1. Connect the MiniProg3 to the J2 connector, with the VDD of the MiniProg3 aligned to the VDDD 
on the module.

2. Click Start > All Programs > Cypress > PSoC Programmer <version> > PSoC Programmer 
<version>.

3. Open the desired .hex file in PSoC Programmer.

4. On the Programmer tab, set the Programming Mode to Reset.

5. Set AutoDetection to On.

6. Set Programmer Characteristics > Protocol to SWD.

7. Set Programmer Characteristics > Voltage to the desired value.

8. Click the Toggle Power icon below the menu bar to power the module.

9. Click the Program icon below the menu bar to program the module.



CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *G 149

A.5 BLE Modules and BLE Dongles Compatible with the BLE Pioneer 
Kit

Different BLE modules and BLE dongles can work with the BLE Pioneer Kit, as listed in the following
tables.

A.5.1 CY8CKIT-142 PSoC 4 BLE Module

This is the default PSoC 4 BLE Module shipped as part of the BLE Pioneer Kit (it can also be
ordered separately). This module has the CY8C4247LQI-BL483 silicon, with 128KB flash and 16KB
RAM.

Figure A-3.  CY8CKIT-142 PSoC 4 BLE Module

BLE Module Availability Flash Size Bluetooth Version

CY8CKIT-142 PSoC 4 BLE Module As part of the kit 128KB Bluetooth 4.1

CY8CKIT-141 PSoC 4 BLE SMA Module Available separately 128KB Bluetooth 4.1

CY8CKIT-143 PSoC 4 BLE 256KB Module Available separately 256KB Bluetooth 4.1

CY8CKIT-143A PSoC 4 BLE 256KB Module Available separately 256KB Bluetooth 4.2

CY5671 PRoC BLE Module As part of the kit 128KB Bluetooth 4.1

CY5674 PRoC BLE SMA Module Available separately 128KB Bluetooth 4.1

CY5676 PRoC BLE 256KB Module Available separately 256KB Bluetooth 4.1

CY5676A PRoC BLE 256KB Module Available separately 256KB Bluetooth 4.2

BLE Dongle Availability Flash Size Bluetooth Version

CY5670 CySmart USB Dongle (BLE Dongle) As part of the kit 128KB Bluetooth 4.1

CY5677 CySmart BLE 4.2 USB Dongle (BLE 
Dongle)

Available separately 256KB Bluetooth 4.2
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A.5.2 CY8CKIT-141 PSoC 4 BLE SMA Module

This module is identical to the default PSoC 4 BLE Module, except that it has an SMA connector
instead of a wiggle antenna; this connector can be used to connect to an external antenna. This
module can be ordered separately.

Figure A-4.  CY8CKIT-141 PSoC 4 BLE SMA Module

A.5.3 CY8CKIT-143 PSoC 4 BLE 256KB Module

This is the higher flash equivalent of the PSoC 4 BLE Module. It has the CY8C4248LQI-BL483 sili-
con, with 256KB flash and 32KB RAM. It can be ordered separately.

Figure A-5.  CY8CKIT-143 PSoC 4 BLE 256KB Module
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A.5.4 CY8CKIT-143A PSoC 4 BLE 256KB Module

This module is similar to the CY8CKIT-143 Module, but supports Bluetooth 4.2 features and DMA. It
has the CY8C4248LQI-BL583 silicon, with 256KB flash and 32KB RAM. It can be ordered sepa-
rately.

Figure A-6.  CY8CKIT-143A PSoC 4 BLE 256KB Module

A.5.5 CY5671 PRoC BLE Module

This is the default PRoC BLE Module shipped as part of the BLE Pioneer Kit (it can also be ordered
separately). This module has the CYBL10563-56LQXI silicon, with 128KB flash and 16KB RAM.

Figure A-7.  CY5671 PRoC BLE Module
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A.5.6 CY5674 PRoC BLE SMA Module

This module is identical to the default PRoC BLE Module, except that it has an SMA connector
instead of a wiggle antenna; this connector can be used to connect to an external antenna. This
module can be ordered separately.

Figure A-8.  CY5674 PRoC BLE SMA Module

A.5.7 CY5676 PRoC BLE 256KB Module

This is the higher flash equivalent of the PRoC BLE Module. It has the CYBL10573-56LQXI silicon,
with 256KB flash and 32KB RAM. It can be ordered separately.

Figure A-9.  CY5676 PRoC BLE 256KB Module
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A.5.8 CY5676A PRoC BLE 256KB Module

This module is similar to the CY5676 Module, but supports Bluetooth 4.2 features and DMA. It has
the CYBL11573-56LQXI silicon, with 256KB flash and 32KB RAM. It can be ordered separately.

Figure A-10.  CY5676A PRoC BLE 256KB Module

A.5.9 CY5670 CySmart USB Dongle (BLE Dongle)

This is the BLE Dongle shipped as part of the BLE Pioneer Kit (it can also be ordered separately). It
has the CYBL10162-56LQXI silicon, with 128KB flash and 16KB RAM.

Figure A-11.  CY5670 CySmart USB Dongle (BLE Dongle)
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A.5.10 CY5677 CySmart BLE 4.2 USB Dongle (BLE Dongle)

This is the higher flash equivalent of the default BLE Dongle. It has the CYBL11573-56LQXI silicon,
with 256KB flash and 32KB RAM, and supports Bluetooth 4.2 and DMA. It can be ordered sepa-
rately.

Figure A-12.  CY5677 CySmart BLE 4.2 USB Dongle (BLE Dongle)
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A.6 Migrating Projects Across Different Pioneer Series Kits

All Cypress Pioneer series kits are Arduino Uno-compatible and have some common onboard
peripherals such as RGB LED, CapSense, and a user switch. However, the pin mapping in each of
the boards is different due to differences in pin functions of the PSoC device used. This guide lists
the pin maps of the Pioneer series kits to allow easy migration of projects across different kits.

In some cases, the pins available on the Pioneer kit headers are a super set of the standard Arduino
Uno pins. For example, J2 contains only one row of pins on the Arduino Uno pinout while it contains
two rows of pins on many of the Pioneer series kits.

Figure A-13.  Pioneer Series Kits Pin Map

Pioneer series kits

J1
J2

J3 J4

18 1

2

11 810

17

18

11

12

CY8CKIT-040

CY8CKIT-042-BLE

CY8CKIT-042 & CY8CKIT-044

6x1 header

6x2 header

9x2 header

Arduino compatible
I/O headers

Arduino compatible
power header
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A.6.1 Arduino Uno-Compatible Headers

J1 Arduino-Compatible Header Pin Map

Pin # Arduino Pin
Pioneer Series Kits

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 VIN VIN VIN VIN VIN

2 GND GND GND GND GND

3 GND GND GND GND GND

4 5V V5.0 V5.0 V5.0 V5.0

5 3.3V V3.3 V3.3 V3.3 V3.3

6 RESET RESET RESET RESET RESET

7 IOREF P4.VDD P4.VDD BLE.VDD P4.VDD

8 NC NC NC NC NC

J2 Arduino-Compatible Header Pin Map

Pin # Arduino Pin
Pioneer Series Kits

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 A0 P2[0] P0[0] P3[0] P2[0]

2 – P0[2]* – P2[0] P2[6]*

3 A1 P2[1] P0[1] P3[1] P2[1]

4 –- P0[3]* – P2[1]* P6[5]*

5 A2 P2[2] P0[2]* P3[2] P2[2]

6 – P4_VDD – P2[2]* P0[6]*

7 A3 P2[3] P0[4]* P3[3] P2[3]

8 – P1[5]* – P2[3]* P4[4]*

9 A4 P2[4] P1[3] P3[4] P2[4]

10 – P1[4]* – P2[4]* P4[5]*

11 A5 P2[5] P1[2] P3[5] P2[5]

12 – P1[3]* – P2[5]* P4[6]*

13 – P0[0] – – P0[0]

14 – GND – – GND

15 – P0[1] – – P0[1]

16 – P1[2]* – – P3[4]*

17 – P1[0] – – P0[7]*

18 – P1[1]* – – P3[5]*

* These pins are also used for onboard peripherals. See the tables in “Onboard Peripherals” on page 158 for 
connection details.
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J3 Arduino-Compatible Header Pin Map

Pin # Arduino Pin
Pioneer Series Kits

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 D8 P2[6] P1[4] P0[5] P0[2]

2 D9 P3[6] P1[5] P0[4] P0[3]

3 D10 P3[4] P1[6] P0[2] P2[7]

4 D11 P3[0] P1[1]* P0[0] P6[0]

5 D12 P3[1] P3[1] P0[1] P6[1]

6 D13 P0[6] P1[7] P0[3] P6[2]

7 GND GND GND GND GND

8 AREF P1[7] NC VREF P1[7]

9 SDA P4[1] P1[3] P3[4] P4[1]

10 SCL P4[0] P1[2] P3[5] P4[0]

* These pins are also used for onboard peripherals. See the tables in “Onboard Peripherals” on page 158 for 
connection details.

J4 Arduino-Compatible Header Pin Map

Pin # Arduino Pin
Pioneer Series Kits

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 D0 P0[4] P0[5] P1[4] P3[0]

2 D1 P0[5] P0[6] P1[5] P3[1]

3 D2 P0[7]* P0[7] P1[6] P1[0]

4 D3 P3[7] P3[2]* P1[7] P1[1]

5 D4 P0[0] P0[3] P1[3] P1[2]

6 D5 P3[5] P3[0] P1[2] P1[3]

7 D6 P1[0] P1[0] P1[1] P5[3]

8 D7 P2[7] P2[0]* P1[0] P5[5]

* These pins are also used for onboard peripherals. See the tables in “Onboard Peripherals” on page 158 for 
connection details.
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A.6.2 Onboard Peripherals

CapSense Pin Map

Pin # Description

Pioneer Series Kits

CY8CKIT-042 
(Linear Slider)

CY8CKIT-040
CY8CKIT-042-BLE 

(Linear Slider)
CY8CKIT-044 
(Gesture Pad)

1 CSS1 P1[1] – P2[1] P4[4]

2 CSS2 P1[2] – P2[2] P4[5]

3 CSS3 P1[3] – P2[3] P4[6]

4 CSS4 P1[4] – P2[4] P3[4]

5 CSS5 P1[5] – P2[5] P3[5]

6 CMOD P4[2] P0[4] P4[0] P4[2]

7 CTANK P4[3] P0[2] P4[1] P4[3]

Proximity Header Pin Map

Pin # Description
Pioneer Series Kits

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1
PROXIMITY

– P2[0] P2[0] P3[7]

2 – – – P3[6]

RGB LED Pin Map

Pin # Color
Pioneer Series Kits

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 Red P1[6] P3[2] P2[6] P0[6]

2 Green P0[2] P1[1] P3[6] P2[6]

3 Blue P0[3] P0[2] P3[7] P6[5]

User Switch Pin Map

Pin # Description
Pioneer Series Kits

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 SW2 P0[7] – P2[7] P0[7]
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